
Chapter 3

Creating Building 
Envelopes

Learning Objectives
After completing this chapter, you will be able to:
• Understand the concept of Levels
• Understand the concept of Grids
• Work with Project Views
• Understand walls
• Add doors and windows
• Create openings in walls
• Create ceilings
• Create floors
• Create rooms
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INTRODUCTION
The building envelope behaves as a physical barrier between the interior and exterior of a 
building. It comprises of walls, floors, roofs, fenestrations and doors. In a project, fenestration 
are any opening in the structure such as windows, skylights, clerestories, etc. In a Revit project, 
the building envelope also comprises of beams, columns, datum elements, and standard views.

In an HVAC system, the building envelope is considered as an important aspect of an HVAC 
design. The building evelope is the outer shell that maintain a dry, heated, or cooled indoor 
environment and facilitate its climate control. Building envelope design is a specialized area of 
architectural and engineering practice that draws from all areas of building science and indoor 
climate control. While working in an MEP project you can either create a building envelope in 
the current MEP project or link the architectural and structural models created in Revit to the 
current MEP project.

In this chapter, you will learn about various tools and options to create the Building Envelope 
for carrying out an MEP project. 

LEVELS
Levels, in a multistory building, refer to the infinite horizontal planes that define each story of 
the structure. Autodesk Revit uses levels as references for level-hosted elements such as walls, 
ducts, AHUs, air terminals, pipes and pipe fixtures, sanitary fixtures, floor, roof, ceiling, and 
so on. The distance between levels can be used to define the story height of a building model, 
as shown in Figure 3-1. Autodesk Revit also provides flexibility to create a non-story level or a 
reference level such as sill level, parapet level, and so on.

Figure 3-1  The elevation view of a building model displaying different levels
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For example, a multistory office building, refer to Figure 3-1, displays different story heights for 
each floor. MEP and architectural components such as ducts, pipes, fixtures, electrical wiring, 
fire fighting fixtures, exterior walls, windows, doors, and furniture may also differ on each 
floor. You can create levels based on the story height of a building. You can then create various 
building elements on each level such as an entrance door on the first floor level, bay windows 
on the second floor level, an elevator room on the roof level, and so on.

When you use the default template file for creating a new project file, two predefined levels, Level 
1 and Level 2, are displayed in the elevations or section views. You can view any of the elevation 
or section view using the Project Browser. Levels can be added, renamed, and modified at any 
time during the project development.

Tip
In an MEP project, it is recommended to create the levels and save them as a template. On 
doing so, you can save time while working on a project deadline. Also, the number of levels 
that you will create in the template will be based on the type of project your firm frequently 
works on. After you create the levels, you need to assign appropriate plans such as Lighting, 
Power, HVAC Piping, and more based on your requirement for each of the created levels. 

Note
In Revit, you can view the levels in the elevations or section views displayed in the Project Browser 
under each discipline such as Mechanical, Electrical, or Plumbing, refer to Figure 3-2.

Figure 3-2  The Project Browser displaying various 
elevation views for different disciplines
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Tip
If you are using a linked architectural model to create an MEP model, you can reuse the levels 
created in an architectural model for the current MEP model. To do so, choose the Select Link 
tool from Collaborate > Coordinate > Copy/Monitor drop-down. The  use of the Copy/
Monitor tool has already been discussed in Chapter 2 of this textbook. 

Understanding Level Properties
A typical level is represented by a level line, level bubble, level name, level elevation, and so on, 
refer to Figure 3-3. Using these parameters and controls, you can modify the appearance of a level. 
The level name is a modifiable parameter that is used to refer to each level. The level elevation 
is the distance of the level from the base level. The visibility of the level bubble on either side 
of the level line can be controlled by using the bubble display control. The length alignment 
control can be used to align level lines. Autodesk Revit provides the 2D or 3D extents control for 
datums when they are selected. This enables you to change their extents in one or multiple views 
in which they are visible. When a datum is in 3D mode, any modification made in the 3D view 
reflects in all views of the building model. Therefore, you cannot modify a specific view in the 
3D mode. However, 2D mode can be used to modify a datum in a specific view, thereby making 
it view-specific.

Figure 3-3  A section view displaying levels with its various components

Like other building and MEP elements used in an Autodesk Revit project, levels also have 
associated types and instance properties. You can view and modify instance properties of a 
level in the Properties palette. You can also use the Properties palette to view and modify the 
type properties of the selected level. To do so, choose the Edit Type button in the Properties 
palette; the Type Properties dialog box will be displayed. You can use this dialog box to modify 
and view the type properties of the selected level from the drawing. Various properties of level 
are described next.
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Type Properties of Level
The type properties of a level can be viewed and modified in the Type Properties dialog box 
of a level, as shown in Figure 3-4. 

Figure 3-4  The Type Properties dialog box displaying the type parameters of a selected 
level type

When you change the type properties of a level, all its instances are also modified. In the Type 
Properties dialog box of a level, you can modify the value of a parameter by clicking on its 
corresponding Value field and then selecting a new value from the drop-down list or entering 
a new value in the field. Different level type properties are described in the table given next.

Parameter Name Value and Description

Elevation Base	   Describes the elevation base value with respect to the 
project or the shared origin.

Line Weight Refers to the line weight of the level. It can be specified 
by clicking in its Value field and selecting a desired 
option from the drop-down list displayed.
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Color	 Refers to the color of the level line and can be selected 
from the available colors. The default color is black.

Line Pattern	 Used to set the linetype of the level line.

Symbol	 Refers to the symbol indicating the level and can be     
chosen from the drop-down list. The None option    
can be specified if the level head is not required.

Symbol at End 1 Default Check box is selected if a bubble is required at the left    
end of the level line.

Symbol at End 2 Default Check box is selected if a bubble is required at the     
right end of the level line.

Instance Properties of Level
You can change the instance properties of the selected level by using the Properties palette, 
refer to Figure 3-5. When you change the instance properties of a level, the properties of only 
the selected instance are changed.

Figure 3-5  The Properties palette displaying the instance 
parameters of a selected level

The instance properties of a level are described in the following table: 

Parameter Name Value and Description

Elevation Refers to the vertical height of the level from the 
elevation base.

Name	 Refers to the name assigned to the level. You can enter 
any name based on the project requirement.
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Computation Height Specifies the computation height for a level. This value 
is used to compute the area, perimeter, and volume of 
a room.

Structural By default, the check box corresponding to this 
parameter is cleared. You can select the check box to 
define the level as structural. For example, the level 
defined for the top of a foundation can be a structural 
level. 

Building Story By default, the check box corresponding to this 
parameter is selected. As a result, you can define a level 
as a functional story or a floor in the project.

Story Above Specifies the next building story for the level. 

Scope Box Refers to the scope box assigned to the level that 
controls its visibility in different views.

Adding Levels
In Autodesk Revit, you can create multiple levels based on your project requirements. Note 
that the Level tool remains inactive in the Datum panel for all the plan views. The Level tool 
will only be activated in an elevation or section view. To create a level, first select the desired 
section or elevation view on which you want to add the level. Next, invoke the Level tool from 
the Datum panel of the Architecture tab, as shown in Figure 3-6; the Modify | Place Level tab 
will be displayed. In this tab, choose any of the sketching options displayed in the Draw panel 
to create levels in your project. You can also invoke the Level tool by typing LL. In the displayed 
tab, you can select level type from the Type Selector drop-down list to modify an existing level. 
This drop-down list has three level types in Imperial unit system: Level: 1/4” Head, Level: No 
Head, and Plenum. In Metric unit system, the Type Selector drop-down list displays two types 
of levels: Level: 8mm Head and Level: Plenum. To make the level head visible, select the Level: 
1/4” Head option for Imperial or Level: 8mm Head for Metric system. Else, select the Level: 
No Head or Plenum option.

Figure 3-6  Choosing the Level tool from the Datum panel 
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Tip
You can select the Plenum option from the Type Selector drop-down list when you are required 
to add a plenum level. The plenum level is generally added above the ceiling level. This level 
is used to generate a plan view in which you can add spaces to make the heating and cooling 
load analysis of a building accurate.

In the Draw panel of the Modify | Place Level tab, you can use the Line (default selection) 
or Pick Lines tool to sketch a level line. In the Options Bar, the Make Plan View check box is 
selected by default. As a result, while adding a level in a project view, its associated plan view/s 
will be created. To specify the associated view/s to the level, choose the Plan View Types button 
displayed next to the Make Plan View check box; the Plan View Types dialog box will be 
displayed. In the Select view types to create area of this dialog box, two associated views will 
be displayed namely, Ceiling Plan and Floor Plan. You can select any one of them or both from 
the area and then choose OK to close the dialog box; the selected view/s will be associated with 
the level. If you clear the Make Plan View check box, the associated views will not be created. 
The Offset edit box in the Options Bar can be used to add a level at a specified distance from 
the selected point or element. 

To add a level in the current project view(elevation/section), invoke the Level tool and move 
the cursor near the existing levels. On doing so, the temporary dimensions will be displayed, 
indicating the perpendicular distance between the nearest level and the cursor. To add a level 
at the specified distance from the existing level, specify the perpendicular distance value, as 
shown in Figure 3-7.

 

Figure 3-7  Specifying the distance from the existing level
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To sketch a level line, specify its start point and endpoint. The level elevation and the level name 
will be specified simultaneously. Click to specify the first point and move the cursor to the left 
or the right. You will notice that the level line, level name, and elevation appear on the cursor 
and move along with it. Also, if you move the cursor above the endpoint of the existing level 
line, a dashed alignment line will appear, indicating its alignment with the existing level. When 
the alignment line appears, click to specify the endpoint of the level line. You can also specify 
the elevation of the level by entering the value before specifying the start point.

Note
Although you are required to specify the start point and the end point of level lines, the levels 
corresponding to these lines are infinite horizontal planes. However, the placement of the level line 
can be useful in the elevation and section views.

When you select a recently added level, it is highlighted and displays two square boxes, one each 
on either side of the level. These boxes are used to control the visibility of the level bubble. They 
can be selected or cleared to make the bubble visible or invisible at the desired side(s). The two 
small circles representing the drag controls for the level line can be used to increase or decrease 
the length of the level line by dragging. The padlocks act as the length alignment control for 
the alignment of all the level lines. When locked, the modification in the length reflects on all 
the level lines, simultaneously. To modify the length of a level line separately, unlock the control 
and then modify its length.

Modifying Level Parameters
You can change a level type by selecting the level from the drawing and then selecting the 
desired level type from the Type Selector drop-down list in the Properties palette. On 
doing so, the current level will be modified into the selected level. You can also specify the 
properties of the modified level using the Properties palette before adding it. Some of the 
parameters of the level can also be modified by clicking on the level in the drawing window 
and entering the new value.

For example, after selecting a level, you can click on its name and assign a new name to it. As 
you start typing the new name, an edit box appears with the new value.  Also, Autodesk Revit 
prompts you to rename all the associated views such as the floor plan, ceiling plan, and so on, if 
required. If you choose to rename the views, the name of the associated views will change in the 
Project Browser. Similarly, you can modify the elevation of a level by selecting it and entering 
the new temporary dimension value. When you enter a new value, the level automatically moves 
to the specified elevation. 

You can also move levels by simply dragging them to the desired location. Click to select a level(s) 
and drag it to the desired location. As you drag, the elevation level changes dynamically with 
respect to the cursor location. Hold the SHIFT key to move the cursor vertically. Next, release 
the mouse button at the appropriate location to complete the dragging process. When you 
move the cursor near a level,  level will be highlighted. Right-click on the highlighted level line; 
a shortcut menu will be displayed with various options. You can choose the Go to Floor Plan 
option from the shortcut menu to open the corresponding floor plan for the level. On choosing 
the Find Referring Views option from the shortcut menu, the Go To View dialog box will be 
displayed. In this dialog box, select the desired view from the list of views and then choose the 
Open View button; the view in which the selected level is visible will be displayed. 
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For certain levels, you may want to move the level bubble to a different location. When you select 
a level, you will notice a break control, also known as Add elbow, appearing below the level 
name, next to the level bubble. This break control can be used to break the level line and move 
the level bubble away from it. On clicking this control, you will observe that the level name and 
the level bubble are also moved to the new location and an extension line is created. You can 
then use the displayed blue dots to place the level bubble at the appropriate location.

Controlling the Visibility of Levels
You can control the visibility of levels in any of the project views. To do so, select a level 
and right-click; a shortcut menu will be displayed, as shown in Figure 3-8. Choose Hide in 
View > Category from the shortcut menu; the level category will be hidden in the current view. 
To hide a particular level, choose Hide in View > Elements from the shortcut menu; only the 
selected level will be hidden in the current view and will be displayed in all other views. 

Figure 3-8  Choosing the Category option from the shortcut menu

To hide all the levels in a project view, select a level in the project view. Next, choose the 
Override by Category tool from Modify| Levels > View > Override Graphics in View 
drop-down; the View-Specific Category Graphics dialog box will be displayed. In this dialog 
box, clear the Visible check box and choose OK; all levels will be hidden from the current view. 
You can use the Scope Boxes feature to control the visibility of the levels. You will learn about 
this feature later in this chapter. 

WORKING WITH GRIDS
Autodesk Revit provides you the option of creating rectangular or circular grids for your projects. 
Using these grids, you can create building envelopes easily and also place the MEP elements at 
desired locations and intersections.

Creating Grids
You can create grid patterns based on your project requirement. Grid patterns can be rectangular 
or radial, depending on the project geometry. A rectangular grid pattern can be created using 
straight grid lines, whereas a radial grid pattern can be formed using arc grids. The created 
grids are visible in all plan, elevation, and section views. 
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To create a grid line, invoke the view in which you want to create it and then choose the 
Grid tool from the Datum panel of the Architecture tab, as shown in Figure 3-9; the 
Modify|Place Grid tab will be displayed. Using this tab, you can modify the type and instance 
properties of grid. You can also change the grid type by selecting an option from the Type 
Selector drop-down list. The Modify | Place Grid tab, as shown in Figure 3-10, displays 
various options to draw and modify grids in a drawing. The Draw panel in the Modify | 
Place Grid tab displays various tools to draw grids as lines and curves or to convert existing 
model lines into grids. The methods of creating grids are discussed next.

Figure 3-9  Choosing the Grid tool from the Datum panel

Figure 3-10  Various options in the Modify / Place Grid contextual tab

Creating Grids Using the Draw Tools
To create a straight grid line, select any floor plan view from the Project Browser and then 
choose the Grid tool from the Datum panel in the Architecture tab; the Modify | Place Grid 
tab will be displayed. The Line tool in the Draw panel is chosen by default. As a result, you can 
start sketching the grid line by clicking at the appropriate location to specify the start point and 
then moving the cursor to the desired direction. As you move the cursor, you will notice that a 
grid line is created with one end fixed at the specified point and the other end attached to the 
cursor. Also, a temporary angular dimension indicating the angle of the line with the horizontal 
axis is displayed.  Click to specify the endpoint of the grid line when the appropriate angular 
dimension is displayed. You can also sketch an arbitrary inclined grid line and then click on the 
angular dimension to enter a new value of the angle. To draw orthogonal grids, hold the SHIFT 
key and restrict the movement of the cursor to the horizontal and vertical axes. When you click 
to specify the endpoint, a grid is created and its controls are highlighted. The grid thus created 
is highlighted and displays one square box on either side. These boxes are used to control the 
visibility of the grid bubble. They can be checked or cleared to make the grid bubble visible or 
invisible at the desired side(s). The two circles, on either corner, can be dragged to extend or 
reduce the extents of the grid line.

Similarly, when you sketch a new grid line near an existing one, a temporary dimension indicating 
the distance between the two grid lines is displayed. You can enter the value of distance in the 
displayed edit box. Alternatively, you can move the cursor to the desired distance using the 
temporary dimensions. Next, click to specify the start point of the second grid line. To do so, 
move the cursor horizontally to the right and click to specify the endpoint of the grid line when 
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the alignment line is displayed. On doing so, the second grid line is created. Notice that the 
name of this grid is 2. Autodesk Revit automatically numbers the grid lines as they are created. 

Similarly, you can draw other parallel grid lines as well. These lines will be numbered automatically 
as you draw them. The Offset edit box in the Options Bar can be used to create a grid line 
that starts at a specified offset distance from a point defined on an existing element. The offset 
distance can be specified in the Offset edit box in the Options Bar. The shape of the resulting 
grid line depends on the selected sketching tool.

To create vertical grid lines, specify the start point above the first grid line. Now, move the cursor 
vertically downward and click below the last horizontal grid line to specify the endpoint. The 
procedure used for creating multiple horizontal grid lines can be used to create multiple vertical 
grid lines too. 

You can create a rectangular grid pattern that is aligned at a given angle to the horizontal axis. 
You can also specify different angles for the grid lines and create the grid patterns based on the 
project requirement. Figure 3-11 shows some other examples of the rectangular grid patterns.

Figure 3-11  Example of a rectangular grid pattern in an architectural layout

In the Draw panel of the Modify | Place Grid tab, you can use the Start-End-Radius Arc and 
Center-ends Arc tools to create curved or radial grid patterns. The procedure of creating the 
curved grid lines using these options is similar to the sketching options for creating walls, which 
has been discussed later in this chapter. You can create multiple curved grids using the tools 
in the Draw panel and specifying their radius in the Radius edit box in the Options Bar. You 
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can specify a value in the Radius edit box in the Options Bar only if you select the check box 
located before it. 

Tip
You can use the Pick Lines tool to create grid lines that are aligned to the existing elements. 
Invoke this tool from the Draw panel of the Modify / Place Grid tab and move the cursor 
near an existing element and click when the element is highlighted; a grid aligned to the 
highlighted element will be created.  

Creating Grids Using the Multi-Segment Tool
You can use the Multi-Segment tool to sketch a multi-segmented grid in the project. To do so, 
choose the Grid tool from the Datum panel of the Architecture tab; the Modify | Place Grid 
tab will be displayed. In this tab, choose the Multi-Segment tool from the Draw panel; the 
Modify |  Edit Sketch tab will be displayed. In the Draw  panel of the tab, you can choose any 
of the sketching tools, displayed in the list box, to sketch the multi-segmented gridline. After 
choosing the desired sketching tool, you need to use various options in the Options Bar to 
control the creation of the gridline in the project. After setting the options in the Options Bar, 
click in the drawing area; a magenta colored gridline with a temporary dimension will emerge 
from the point at which you have clicked. Next, click at the desired location to create the first 
segment of the grid. Similarly, you can click on multiple locations in the drawing area to create 
other segments. To finish the creation of the multi-segmented grids, choose the Finish Edit 
Mode button from the Mode panel of the Modify | Edit Sketch tab. Figure 3-12 shows a sketch 
with multi-segmented gridlines.

Figure 3-12  A multi-segment grid pattern in an architectural layout
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Modifying Grids
As mentioned earlier, grids can be modified once they are created. To modify a grid, you need 
to select it and then modify its properties from the Properties palette. For example, after 
selecting a grid, you can click on its name and assign it a new name. Similarly, you can modify 
the distance between grids by selecting the temporary dimension and entering a new value. 
When you enter a new value, the grid automatically moves to the specified distance. You can 
also move the grids by simply dragging them to the desired location. To do so, click to select a 
single grid or click the multiple grids using the CTRL key to select multiple grids. You can now 
drag the grid(s) to the desired location. Hold the SHIFT key to restrain the movement of the 
cursor in the orthogonal direction. When you move the cursor near a grid, it gets highlighted. 
Now, right-click; a shortcut menu will be displayed with various options such as Select Previous, 
Select All Instances, Create Similar, View Properties, and so on. 
	
For certain grids, you may need to move or offset the grid bubble to a different location. When 
you select a grid, a blue circle appears on each of its endpoints. The drag control, as mentioned 
earlier, controls the extents of the grid line. The grid line break control, which appears near 
the grid bubble, is used to create a grid bubble offset. You can click on this control and use the 
displayed drag controls to move the grid bubble to the desired location. While moving the grid 
bubble, the grid name also moves to the new location and an extension line is created. 

Grid Properties
Like levels, grids too have associated properties. A typical grid consists of a grid line, grid 
bubble, grid name, and other controls. The usage of the controls such as grid bubble visibility, 
2D or 3D extents, and grid bubble break is similar to the usage of controls described for levels. 

To view and modify the properties of a grid, select it; the instance parameter of the selected 
grid will be displayed in the Properties palette. In this palette, choose the Edit Type button; the 
Type Properties dialog box will be displayed. You can use this dialog box to view and modify 
the type properties of the selected grid. The type properties of grids and their description are 
discussed next.

Type Properties of Grids 
When the type properties of a grid are changed, the properties of all instance parameters 
related to it are also changed. You can click in the Value field and select a new value from 
the corresponding drop-down list or enter a new value in that field. The properties of grid 
types are described next.

Parameter Name Value and Description

Symbol Refers to the display of the symbol at the end 
of the grid line. You can control the display 
of the symbol by selecting an option from the 
drop-down list.

Center Segment Refers to the display type of the center segment 
of the grid line. You can select Continuous, 
None, or Custom from the drop-down list.

Center Segment Weight Refers to the line weight of the center segment, 
if the Center Segment parameter is set to 
Custom.
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Center Segment Color You can assign a color to the center segment 
if the Center Segment parameter is set to 
Custom.

Center Segment Pattern Refers to the line type of the segment at the 
center if the Center Segment parameter is set 
to Custom. You can select various line patterns 
from the drop-down list.

End Segment Weight Refers to the line weight of the grid line 
if the Center Segment parameter is set to 
Continuous. You can set the line weight of 
the end segments if the Center Segment 
parameter is set to None or Custom. 

End Segment Color Refers to the color assigned to the grid line 
if the Center Segment parameter is set to 
Continuous. You can set the color of the end 
segments if the Center Segment parameter is 
set to None or Custom.   

End Segment Pattern Refers to the line type of the grid line if 
the Center Segment parameter is set to 
Continuous. You can set the line type of 
the end segments if the Center Segment 
parameter is set to None or Custom.

End Segments Length Refers to the length of each end segment 
as measured in the sheet if the Center Segment 
parameter is set to None or Custom.

Plan View Symbols End 1(Default) Refers to the default status for the visibility of 
the symbol at end 1 of the grid line in plan 
views. By default, the check box is cleared. If you 
select the check box, the visibility of the symbol 
at end 1 in the plan view will be turned on.

Plan View Symbols End 2(Default) Refers to the default status for the visibility of the 
symbol at end 2 of the grid line in the plan views. 
By default, the check box is selected. If you clear 
the check box, the visibility of the symbol at end 2 
in the plan view will be turned off.

Non-Plan View Symbols (Default) Refers to the default status for the visibility of 
the grid line in the sections and elevations, 
other than in the plan views. You can control 
the visibility of the symbol at the top and 
bottom of the grid line by selecting the desired 
option from the drop-down list.
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Instance Properties of Grids
The instance properties of grids are given next.

Parameter Name Value and Description
Name	 Refers to the name assigned to the grid. You 

can enter any name, based on the project 
requirement.

Scope Box Refers to the scope box assigned to the grid 
that controls its visibility in different views.

Tip
In Revit 2021 onwards, you can now display the grids in the 3d Views for specified level(s). 
To do so, choose the Edit option corresponding to the Show Grids parameters displayed in 
the Properties palette of the 3d view.

REFERENCE PLANES
Reference planes are useful while sketching and adding building elements to a design. They can 
be used as datum planes that act as a guideline for creating elements. They can also be used 
effectively for creating new family elements. To create a reference plane, choose the Ref Plane 
tool from the Work Plane panel of the Architecture tab; the Modify | Place Reference Plane tab 
will be displayed. Select the tools from the Draw panel and start drawing the reference plane in 
the drawing. Alternatively, you can type RP to invoke the Ref Plane tool. 

After invoking the tool, click at the desired location in the drawing window to start a line that 
defines the reference plane. Now, move the cursor to the new location and release the left button 
to specify the endpoint of the reference line; the reference plane will be created. To assign a 
name to the reference plane, select it from the drawing. Next, in the Properties palette, enter the 
desired name of the selected reference plane in the value field of the Name instance parameter. 

WORK PLANES
As the name suggests, the work plane is a plane that can be used for sketching elements. In 
Autodesk Revit, you can create and edit only those elements that lie in the current work plane. 
The work plane can be horizontal, vertical, or inclined at any specified angle. Each generated 
view has an associated work plane. This workplane is automatically defined for some standard 
views such as floor plans. For other views such as sections, elevations, and 3D views, you can set 
the work plane based on the location of the elements that are to be created or edited. The concept 
of work planes is quite useful for creating elements in elevations, sections, or inclined planes. 

Setting a Work Plane
You can set a work plane based on your project requirement. To set a work plane, choose the 
Set tool from the Work Plane panel in the Architecture tab; the Work Plane dialog box will be 
displayed. It shows the current work plane and assists you in specifying the parameters to set 
a new work plane. A drop-down list of available views is displayed corresponding to the Name 
radio button. Select the required work plane from the drop-down list, which contains the names 
of levels, grids, and reference planes. You can select the Pick a plane radio button in the Work 
Plane dialog box to set a work plane along an existing plane. On selecting this radio button and 
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choosing the OK button in this dialog box, you will be prompted to select an existing plane 
in the drawing with which you want to align the new work plane. The existing plane can be a 
face of a wall, floor, or roof. You can also select the Pick a line and use the work plane it was 
sketched in radio button from this dialog box to create a work plane that is coplanar with the 
plane on which the selected line was created.

Note
In the project environment of Autodesk Revit, you can choose the Viewer tool from the Work Plane 
panel of the Architecture tab to display the Workplane Viewer window. In this window, you can 
modify the workplane dependent element with an ease.

Controlling the Visibility of Work Planes
You can control the visibility of the current work plane by using the Show button from the 
Architecture tab. This button is used to toggle the display of grids in the workplane. 

You can also set the grid spacing for a work plane. To do so, select the workplane in the 
drawing, the work plane will be highlighted. Specify the spacing by entering the new value in 
the Spacing edit box in Options Bar. You can snap to the work plane grid using the object 
snap tools. 

WORKING WITH PROJECT VIEWS
While working on the building envelope and MEP models, you may need to view its different 
exterior and interior portions in order to add or edit the elements in the design. Revit provides 
various features and techniques that can be used to view the building model. 

Viewing a Building Envelope
In Revit, the default template file (Mechanical, Electrical, Plumbing, or Systems) has certain 
predefined standard project views. These views are displayed under the Views head of the Project 
Browser, as shown in Figure 3-13. 

Figure 3-13  Project Browser displaying various project views
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These include floor plans (Mechanical, Electrical, and  Plumbing), ceiling plans (Mechanical, 
Electrical, and Plumbing), elevations, sections, and 3D Views. To open any of these views, 
double-click on the name; the corresponding view will be displayed in the viewing area. You can 
control the visibility of the Project Browser by selecting the Project Browser check box from 
the View > Windows > User Interface drop-down.

W hen you open a new project, the viewing area displays four inward arrow symbols in the floor 
plan view, which indicate the four side elevations: North, East, South, and West. You can use 
these symbols to view the appropriate building elevation by double-clicking on them. 

Apart from these standard building views, you can use different viewing tools to view the building 
model from various angles. To restrict the visibility of certain categories of elements, choose 
the Visibility/Graphics tool from the Graphics panel of the View tab; the Visibility/Graphic 
Overrides dialog box will be displayed. The Model Categories tab of this dialog box contains 
a list of model elements such as Air Terminal, HVAC Zones, doors, windows, and so on. The 
Annotation Categories tab contains annotations such as duct tags, flex pipe tags, wire tags 
dimensions, door tags, and so on. You can clear the category of elements that you want to hide 
from the current view using this dialog box.

Overriding the Visibility/Graphic of an Element
You can override the visibility and graphics of any element in a view. To do so, select an element 
and right-click; a shortcut menu will be displayed. Choose Override Graphics in View > By 
Element from the shortcut menu; the View-Specific Element Graphics dialog box will be 
displayed, as shown in Figure 3-14. The options in this dialog box are discussed next.

Figure 3-14  The View-Specific Element Graphics dialog box

Visible
The Visible check box controls the visibility of an element in a view. This check box is selected by 
default. As a result, the selected elements are visible in view. Clear the check box to hide the 
selected element in the view.
 
Halftone
Select the Halftone check box to adjust and blend the line color of an element with the 
background color.
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Projection Lines
Choose the arrow button on the left of this option; the Weight, Color, and Pattern options of 
the projection lines will be displayed. Set the line weight of the projection lines using the options 
in the Weight drop-down list. To change the color of a projection line, choose the button at the 
right of the Color option; the Color dialog box will be displayed. Select the required color from 
the dialog box and choose the OK button. To change the pattern of the projection lines, choose 
the button at the right of the Pattern option; the Line Patterns dialog box will be displayed. 
Select a pattern of the projection lines from the dialog box and choose the OK button. 

Surface Patterns
Choose the arrow button on the left of the Surface Patterns  option to expand it. You can change 
the visibility of the surface pattern by clearing the Visible check box. Select the color and pattern 
of the surface in the same way as explained earlier for the projection lines.

Surface Transparency
Choose the arrow button on the left of the Surface Transparency option to expand it. In this 
area, you can change the transparency of the selected element by moving the Transparency 
slider or by entering a suitable value in the edit box displayed next to the slider. Note that higher 
the value you enter in the edit box, more transparent will be the object. 
 
Cut Lines/Cut Patterns
Choose the arrow button on the left of these options to expand them. Change the visibility, weight 
and pattern of the cut lines or cut patterns, as explained earlier for the Projection Lines option. 
Once you have edited the graphics and visibility settings of an element in the View Specific 
Element Graphics dialog box, choose the Apply button to view the changes in the selected 
element. Choose the OK button to retain the settings and close the dialog box. 

Overriding the Visibility/Graphic of Element Category
To edit the visibility and graphics of an element category in a project view, open the project 
view. Next, select an element of the required category and right-click; a shortcut menu will be 
displayed. Choose Override Graphics in View > By Category from the shortcut menu; the 
View -Specific Category Graphics dialog box will be displayed. Choose the Open  the Visibility 
Graphics dialog button; the Visibility/Graphic Overrides for Floor Plans dialog box for the 
loaded view will be displayed, refer to Figure 3-15. 

The dialog box contains various tabs. The options in these tabs are used to edit the settings for 
the visibility and graphic display of the models, annotations, and imported elements. Choose a 
tab to edit the visibility and graphics of the selected category. To edit the visibility in the view, 
clear or select the visibility check box available on the left of the category name in the Visibility 
column. To specify overrides to a category, click on the name of the category in the Visibility 
column; the Overrides button will be displayed for the respective column in the specified tab. To 
override patterns for the selected category, choose the Override button displayed in the Patterns 
column corresponding to the selected category; the Fill Pattern Graphic dialog box will be 
displayed. Set the visibility, color, and pattern by using the Visible, Color, and Pattern options, 
respectively in the dialog box and choose the OK button. Similarly, to override the transparency 
of the selected object, choose the Override button displayed in the Transparency column; the 
Surfaces dialog box will be displayed. In this dialog box, you can use the Transparency slider 
to control the transparency of the selected element.   
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Similarly, click in the required columns in the Visibility/Overrides dialog box to edit the graphic 
display of the category. Select the check boxes in the Halftone column, if required. You can set 
the detail level of the selected category in the Detail level column. To do so, click in the Detail 
Level column and choose the down arrow displayed on the left. Select the detail level from 
the Detail Level drop-down list displayed. Choose the Apply button to view the changes in 
the visibility and graphic display of the selected category. Choose the OK button to retain the 
changes and close the Visibility/Graphics Overrides dialog box.

Figure 3-15  The Visibility/Graphics Overrides for Floor Plan dialog box

Making Elements Transparent
Revit provides you with a tool to make elements transparent so that you can see through them. 
This tool can be used to view the interior of a building from the top even after adding roofs or 
ceilings.

To make an element transparent, select it and right-click; a shortcut menu will be displayed. 
Choose Override Graphics in View > By Element from the shortcut menu; the View Specific 
Element Graphics dialog box will be displayed. In this dialog box, click on the arrow on the 
left of the Surface Transparency area; the options in this area will be displayed. In this area, the 
Transparency slider is used to control the transparency of the selected object. You can increase 
the transparency by moving the slider toward right. Alternatively, you can enter a desired value in 
the edit box, next to the Transparency slider, to control the transparency of the selected element. 
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After setting the transparency in the Surface Transparency area, choose the OK button; the 
selected element will become transparent and you will be able to see through it. Although the 
element becomes transparent, the edges and surface pattern of the element will still be visible. 
You can view the change in the element before and after using the Transparency slider.
 

Using the Temporary Hide/Isolate Tool
The Temporary Hide/Isolate tool can be used to hide or isolate elements temporarily from 
a project view. This tool will be available only after a selection is made. Select the element or 
elements that you need to hide or isolate in the project view and then choose the Temporary 
Hide/Isolate tool from the View Control Bar; a cascading menu will be displayed. You can hide 
or isolate elements or their categories using the tools or options given in the cascading menu. It 
contains six tools. On choosing any of the tools from it, a cyan color border will be displayed in 
the drawing area, indicating that the elements in the drawing are in the Temporary Hide/Isolate 
mode. You can choose the Hide Element tool from the cascading menu, refer to Figure 3-16, 
to hide the selected element in a view. On choosing the Isolate Element tool, only the selected 
elements will be displayed in the view while the rest will be hidden. The Hide Category tool is 
used to hide all the elements of the category of the selected element. The Isolate Category is 
used to display only the elements belonging to the category of the selected element in the view. 

The Reset Temporary Hide/Isolate tool is used to revert to the original view without saving 
the temporary or isolate changes in the view. The Apply Hide/Isolate to view option is used 
to hide or isolate the temporary hidden or isolated elements permanently in the view. On 
choosing this tool, the blue boundary around the screen becomes invisible and the temporarily 
hidden or isolated elements and categories are permanently hidden or isolated. On hiding or 
isolating an element or category, the sunglasses symbol of the Temporary Hide/Isolate tool in 
the View Control Bar is highlighted in the same color as that of the boundary, indicating that 
certain elements have been hidden temporarily. When you choose the Reset Temporary Hide/
Isolate option, the sunglasses symbol is no longer highlighted.

Figure 3-16  Choosing the Hide Element tool from the View Control Bar

Revealing and Unhiding Elements
To reveal and unhide the hidden elements in the view, choose the bulb icon from the View Control 
bar to invoke the Reveal Hidden Elements tool. On doing so, a magenta color border will be 
displayed and the hidden elements will be highlighted in the same color. Select the required 
elements and choose the Unhide Element or the Unhide Category button from the Reveal 
Hidden Elements panel in the Architecture tab. Now, again you need to click on the bulb icon 
to invoke the Exit Reveal Hidden Elements mode. You will notice that all the hidden elements 
and categories will be displayed in the view.
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Plan Views
In Autodesk Revit, you can use the floor and ceiling views to view the building plan of the 
respective discipline. If you are using the Systems-Default.rte template file to start a new 
project, by default Autodesk Revit opens the 1-Mech floor plan view. The Systems-Default.rte 
template file contains floor plans for the Electrical, Mechanical, and Plumbing disciplines and 
ceiling plans for Electrical and Mechanical discipline.
  
Adding a Plan View
To create a new plan view for the added levels that do not contain associated plans in the Project 
Browser, choose the Floor Plan tool from View > Create > Plan Views drop-down; the New 
Floor Plan dialog box will be displayed, as shown in Figure 3-17. In the New Floor Plan dialog 
box, the Floor Plan option is selected in the Type drop-down list, refer to Figure 3-17. You can 
edit the existing type or create a new type by choosing the Edit Type button. On choosing the 
Edit Type button; the Type Properties dialog box will be displayed. In this dialog box, you 
can edit various type parameters for the existing view type or choose the Duplicate button and 
create a new type. Choose the OK button to return to the New Floor Plan dialog box. In this 
dialog box, you can select the appropriate level to create the plan view in the list box displayed. 
You can also select multiple levels by holding the SHIFT key. The Do not duplicate existing 
views check box can be cleared to create a plan view for a level that has an already existing plan 
view. The duplicate view is created and added in the Project Browser with the suffix (1). The 
number in the brackets increases as more copies of the plan view are added. 

Figure 3-17  The New Floor Plan dialog box
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Note
While creating a level, if you have cleared the Make Plan View check box in the Options Bar, 
then its corresponding plan view will not be created. 

Modifying the Plan View Properties
To modify the view properties of a plan view or any other project view, select the view from the 
Project Browser; the properties of the selected view will be displayed in the Properties palette. 
Using this palette, you can modify the parameters related to the current view such as View 
Scale, Display Model, Detail Level, View Name, and so on. The View Range parameter in the 
Extents category controls the visibility and appearance of the elements in the view by defining 
the extent of horizontal plane of the view. The crop region parameter defines the boundary of a 
view and can be turned on or off using the Crop Region Visible check box. You can also access 
the tools related to the visibility settings of the view using the View Control Bar available near 
the bottom left corner of the drawing window. 

Elevation Views
An elevation view refers to the view of the building model from the four sides, North, East, South, 
and West. If you are using the default template file, the four sided elevation views are created 
automatically by Autodesk Revit when the default template file is used. Using the elevation view, 
you cannot only visualize the building from its exterior but also create the views of the interior 
walls of various internal spaces.

Creating an Elevation View
To create an elevation view, invoke the Elevation tool from View > Create > Elevation 
drop-down; the Properties palette for the elevation will be displayed. In this palette, select the 
elevation type from the Type Selector drop-down list. On moving the cursor near the exterior 
walls, you will notice that the arrow head of the elevation symbol has changed its alignment and 
become perpendicular to the wall, as shown in Figure 3-18. 

Figure 3-18  The elevation symbol aligned perpendicular to the wall
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Now, click when the elevation arrow head symbol points toward the desired direction; the new 
elevation view will be created and added to the list of elevations in the Project Browser. Revit 
automatically numbers the elevation names.  Note that if you add the elevation symbol in any 
of the  floor  plan view specific to the Mechanical discipline, the elevation corresponding to the 
added elevation symbol will be displayed under the Mechanical discipline of the Elevations 
(Building Elevation) head in the Project Browser, refer to Figure 3-19. 

Figure 3-19  Partial view of the Project Browser with the added elevation

You can also set the width of the elevation view using the clip plane control. When you click on 
the arrow head of the elevation symbol, the clip plane is displayed as a blue line with the drag 
control dots on its two ends. You can drag them to resize the width of the elevation view. For the 
interior elevation views, Autodesk Revit automatically extends the clip plane to the extents of 
the room. You can drag the blue dots to increase or decrease the extents of the elevation view. 
To rename an elevation view, right-click on the view name in the Project Browser; a shortcut 
menu will be displayed. Choose the Rename option from the shortcut menu; the Rename View 
dialog box will be displayed. In this dialog box, enter a desired name in the Name edit box and 
choose the OK button; the elevation view will be renamed.

There are several methods to display an elevation view. To display an elevation view in the drawing 
area, double-click on the name of the elevation in the Project Browser; the corresponding 
elevation view is displayed in the drawing window, as shown in Figure 3-20. You can also display 
the elevation view by double-clicking on the arrow head of the elevation symbol. Alternatively, 
right-click on the elevation symbol; a shortcut menu is displayed. Next, choose Find Referring 
Views from the shortcut menu; the Go To View dialog box will be displayed. Next, select the 
view to be displayed from this dialog box and then choose the Open View button or double-click 
on the name of the view. The other method to display the elevation view is to select the arrow 
head of the elevation symbol and then right-click to display a shortcut menu. Next, choose the 
Go to Elevation View  option from the shortcut menu displayed; the corresponding elevation 
will be displayed in the drawing area.

You can modify the properties associated with elevation views by using the Properties palette. 
This palette is displayed with instance parameters when you select the required view or when 
the required view is displayed in the drawing area.
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Figure 3-20  The elevation view of the building model 

Note
While working on the floor plan, if the created building model extends beyond the clip planes of 
the four sided elevation views, the corresponding elevations no longer show the complete exterior 
views. Instead, an elevation view that is cut through the building model is displayed. You can 
drag the clip plane control symbol beyond the extent of the building profile to retain the view as a 
complete exterior elevation view.

Section Views
Section views are generated by cutting sections through the building model. These views are 
created to display various wall elevations, floor heights, and special vertical features of the 
project. They are also useful in creating and editing elements added to the interior spaces of 
the building model.

For example, in an office building, to emphasize the salient features of the central atrium, you 
may need to show a section through the central atrium. Autodesk Revit enables you to create 
it with relative ease. You can also modify the sectional view to create a section that displays the 
interior spaces.
		
Creating a Section View
To create a section view, invoke the Section tool from the Create panel of the View tab; the 
Modify | Section tab will be displayed. The options in the Modify | Section tab are used to 
specify the section type to be created and to specify the instance and its type properties. The 
section can be created in the plan, elevation, and section views. You can create different types 
of section views such as the building section, wall section, and detail section. You can choose the 
section view type to be created from the Type Selector drop-down list in the Properties palette. 
In the Options Bar, you can use the Reference Other View check box to create a reference 
section that acts as a reference for another view. Notice that the reference sections are not added 
as an additional section in the list of section views in the Project Browser.

To create a section, invoke the Section tool from the Create panel and move the cursor to the 
viewing area; the cursor will change into a cross symbol and you will be prompted to draw the 
section line in the current view. Click at the desired location to specify the start point. To create 
a section through a specific length of an area, click at desired point in the area. As you move 
the cursor, a section line will appear with one end fixed at the specified point and the other end 
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attached to the cursor. You can even create a section line at any angle. To create a horizontal 
or vertical section view, move the cursor horizontally or vertically across the area, as shown in 
Figure 3-21 and click to specify the endpoint. The section line along with its controls is shown 
in Figure 3-22. It is represented by a section head and a line. The section head indicates the 
direction toward which the section will be created. Note that, the methods used for displaying 
the section views are similar to the ones described for the elevation views.

Figure 3-21  The  section line drawn horizontally across the plumbing layout

Figure 3-22  The section line displayed along with its controls

Modifying a Section View
After creating a section view, you can modify the location of the section line of the section 
view by dragging it. When you drag a section line, the corresponding section view is updated 
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immediately. You can modify the parameters of the section view by using the controls available 
on the section view line. When you select the section line, the controls are displayed in it. The 
twin arrow symbol represents the flip tool that can be used to flip the viewing side of the section 
view. By default, the section head appears on one side. The cyclic control on both the ends of 
the section line can be used to change the visibility of the section head and tail at the respective 
ends. You can click on the symbol to hide or display them. Click on the break line symbol, which 
appears in the middle of the section line, to break it. You can then resize the two section lines to 
the required extent of the view. To rejoin the section line, click on the break line control again.
When you create a section view, Autodesk Revit intuitively creates its view depth, which is the 
extent of the view in the current view. It is represented by a dashed line and the blue arrows as 
drag controls. To modify the view depth, drag the arrows to the desired location. The section view 
shows only those elements that are within the view depth. To modify the properties of a section 
view, select its section line; the Properties palette will be displayed with the instance parameters 
of the section view. Using this palette, you can modify various instance properties such as View 
Name, View Scale, Crop Region Visible, and so on. To do so, click in the corresponding field 
in the Value column and select a new value from the drop-down list if available, or enter a new 
value in that field. 

You can choose the Edit Type button to display the Type Properties dialog box and modify the 
type properties of the section view such as Callout Tag, Section Tag, and Reference Label from it.

Creating a Segmented Section
Autodesk Revit enables you to split the section into segments that are orthogonal to the direction 
of the section view. This enables you to show different parts of the building model in the same 
section view. 

To create a segmented section, create a straight section line in the drawing area and then choose 
the Split Segments tool from the Section panel of the Modify | Views tab. On doing so, a split 
symbol will be attached to the cursor. Move it over the section line and click at the point from 
where you want to split it. Move the cursor perpendicular to the section line; it will break from 
the specified point. Next, you can move the cursor in the desired direction to split the section 
line along the head or tail side. Click again to specify the location of the split segment. 

Controlling the Visibility of a Section Line
The section line is visible in plan, section, and elevation views, if the view range of the created 
views intersects the crop region of the current view. The section line created in any view is visible 
and is created simultaneously in all the other views.
 
You can also control the visibility of the section line in the views. To do so, select the section line, 
right-click, and choose the Hide in View > Element option from the shortcut menu displayed. 
The selection line becomes hidden in the current view.

Note
The section of elements is displayed when a section is cut through them. Sections through in-place 
elements are not available; therefore they are not displayed in the section view.

Creating a Detail and a Wall Section View
In Autodesk Revit, you can create different types of section views. There are  three different 
types of section views such as detail, building, or wall section view in both the Imperial and the 
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Metric systems. These section views can be selected from the Type Selector drop-down list in 
the Properties palette.

To create a detail section view from the building model, select the Detail View : Detail option from 
the Type Selector drop-down list of the Properties palette. Similarly, to create a building section 
or a wall section of the building model, select the Section : Building Section or Section : Wall 
Section option from the Type Selector drop-down list. After creating a wall section using the 
Section : Wall Section type, you will notice that its section view has been added to the list of 
sections under the subhead Sections (Wall Sections) in the Project Browser and you can display 
it by double-clicking on the section name. Similarly, a section view created as a building section 
or a detail section will be displayed in the subhead Sections (Building Sections) or Detail Views 
(Detail), respectively. You will learn more about these views in the later chapters.

Using the Scope Box Tool
Autodesk Revit provides you the option of controlling the visibility of the datum elements in the 
project views using the Scope Box tool. As described earlier in this chapter, the datum planes 
have an infinite scope and extend throughout the project. Using the Scope Box tool, you can 
limit the boundary for the visibility of the datum planes. You can also specify the views in which 
these datum planes become visible. 

Creating a Scope Box
The Scope box can be created in the plan view by invoking the Scope Box tool. You can invoke 
this tool from the Create panel of the View tab; the Options Bar displays the Name and Height 
edit boxes. You can enter the name and height of the scope box in these edit boxes. To create 
a scope box, move the cursor in the viewing area. It changes into a cross symbol, that prompts 
you to draw the scope box in the plan view. To draw the scope box, click on its upper left corner, 
move the cursor to the lower right corner, and then click to specify the diagonally opposite ends 
to draw a rectangle. The rectangle should be drawn in such a way that the elements that need 
to be visible are enclosed in it. The scope box with the assigned name is created. When it is 
selected, the drag controls are visible on it, as shown in Figure 3-23. These drag controls can 
be used to resize the scope box. 

Figure 3-23  The selected scope box in a plumbing layout



Creating Building Envelopes			   3-29

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Applying the Scope Box
The visibility of datum planes can be controlled by associating them with the scope box. You can 
select a datum such as a grid, a level, or a reference plane, and then in the Properties palette, 
click in the value column for the Scope Box parameter and select the name of the scope box 
from the drop-down list displayed. Now, choose the Apply button to apply the property to the 
selected datum. The datum will now appear only in those views whose cutting planes intersect 
the scope box.

Controlling the Visibility of the Scope Box
The scope box can be resized to limit its visibility for certain views. Its visibility can also be 
controlled for each view. To control the visibility of the scope box, select it; the instance properties 
of the selected scope box will be displayed in the Properties palette. In the Parameters area of 
the palette, choose the Edit button displayed in the value field for the Views Visible parameter; 
the Scope Box Views Visible dialog box will be displayed. This dialog box lists all view types and 
view names available in the project. In the Scope Box Views Visible dialog box, the Automatic 
Visibility column displays the current visibility of scope boxes. You can click in the value field 
in the Override column for a specific view. On doing so, a drop-down list will be displayed, 
as shown in Figure 3-24. The drop-down list has three options: None, Visible, and Invisible. 
You can select any of the options from the drop-down list displayed to override the automatic 
visibility setting.

Figure 3-24  The drop-down list displayed in the Scope Box Views Visible dialog box

UNDERSTANDING WALL TYPES
Autodesk Revit provides you with several predefined wall types based on their usage. These wall 
types are discussed next
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Exterior Wall Type
This is the wall type that is primarily used for generating the exterior of the building model. It has 
predefined wall types, such as Brick on CMU, Brick on Mtl. Stud, CMU Insulated, and so on.

Curtain Wall Type
Apart from the above discussed wall types, Autodesk Revit also has predefined curtain walls or 
screen walls that consist of panels and mullions. 

Autodesk Revit also provides you with the flexibility of creating your own wall type. The walls 
that you will create can have different functions, which can be modified, depending on their 
functional usage. In Autodesk Revit, you can create both architectural and structural walls. An 
architectural wall does not contain analytical properties as the structural walls do. In the next 
section, various techniques to create and modify architectural walls are discussed.

CREATING ARCHITECTURAL WALLS                       
In Autodesk Revit, each wall type has specific predefined properties such as composition, material, 
characteristics, finish, height, and so on. You can select the wall type based on its specific usage 
in the project. Walls, like most other model elements, can be created in a plan view or a 3D view. 

To create an exterior architectural wall, first you need to invoke the Wall: Architectural tool 
and then select the appropriate exterior wall type and specify various properties. To do so, 
invoke the Wall: Architectural tool from the Build panel, refer to Figure 3-25; the Modify | 
Place Wall tab will be displayed. To select the type of wall, select an exterior wall type from the 
Type Selector drop-down list in the Properties palette, as shown in Figure 3-26. Next, from 
the Properties palette, specify and edit various properties of the wall to be added. Various wall 
properties and the process to specify them are discussed next.    

Figure 3-25  Invoking the Wall: Architectural tool from the 
Wall drop-down
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Specifying Architectural Wall Properties                       
In Autodesk Revit,  walls like other elements, has two sets of properties, type and instance. These 
set of properties control the appearance and the behavior of the concerned element.

Figure 3-26  Selecting an exterior wall type 
from the Type Selector drop-down list

 

Specifying Instance Properties
After invoking the Wall: Architectural tool, the instance properties of the wall will be displayed 
in the Properties palette. The Properties palette also contains the Type Selector drop-down list. 
You can select the family and the type of the proposed wall from this drop-down list. This palette 
shows various instance properties and their corresponding values for the specified instance of 
the element. The options in this palette depend on the type and instance of the selected element 
or the element to be created as well as on the options selected in the Type Selector drop-down 
list. The properties of exterior walls are displayed in different categories such as Constraints, 
Structural, Dimensions, and Identity Data, each representing a set of properties corresponding 
to the title. You can use the twin arrows on the extreme right of the title to collapse the properties 
for each title. Some of the important parameters are discussed next. 

In the Properties palette, the Location Line parameter indicates the reference line used for 
creating a wall. In 3D environment, the location line in a wall refers to a plane that does not 
get modified, even if the wall parameters are changed. To assign a value to the Location Line 
parameter, click in the value field corresponding to this parameter; a drop-down list will be 
displayed. Click on the drop-down list to view the available options. The options in the drop-down 
list are given next.

	 Wall Centerline		 - 	 Center line of the entire composite wall
	 Core Centerline	 - 	 Center line of the structural core of the wall
	 Finish Face: Exterior	 - 	 Exterior face of the wall as the location line
	 Finish Face: Interior	 - 	 Interior face of the wall as the location line
	 Core Face: Exterior	 - 	 Exterior face of the core
	 Core Face: Interior	 - 	 Interior face of the core
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The location line is indicated by a dashed line, which appears while sketching a wall segment. For 
example, on selecting Wall Centerline as the location line parameter, you will notice a dashed 
line in the middle of the wall, as shown in Figure 3-27. When you select Finish Face: Interior, 
dashed line appears on the interior face of the wall, see Figure 3-28.

Figure 3-27  The appearance of a dashed line at the center of the wall

Note 
While developing a design, you may need to modify certain parameters of the exterior wall such 
as its thickness and composition, based on the final selection of materials and their specifications. 
Considering this flexibility, the location line parameter enables you to create the walls.

Figure 3-28  The appearance of a dashed line at the interior face of the wall

In Autodesk Revit, you can specify the height of walls by applying the base and top constraints 
with respect to the levels defined in the project. This means, if you set the base and the height 
parameter of a top story and apply these constraints, all walls will be sketched with the same 
base and the top. To create a wall segment that is not related to these components and levels, 
you can type the desired height in the column of the Unconnected Height instance parameter. 
The default value for the unconnected height in Imperial is 20’ 0” or in Metric is 8000 mm. The 
various instance parameters for walls and their usage are given next. The values of some of the 
instance parameters will be available only after an instance is created. The instance parameters 
of the wall are given in the table below. 

Instance Parameter Description

Location Line	 Line or reference plane for sketching the wall

Base Constraint Level or reference plane of the base of a wall

Base is Attached Check box showing whether or not the base of the wall is  	
attached to any other element
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Base Offset Height of the wall from its base constraint

Base Extension Distance Distance of the base of the layers in a wall

Top Constraint Whether the wall height is defined by specified levels or is 
unconnected

Unconnected Height Explicit height of the wall

Top Offset Distance of the top of the wall from the top constraint

Top Extension Distance Distance of the top of a layer on a wall

Room Bounding Whether the wall constitutes the boundary of a room

Related to Mass Whether the wall relates to a massing geometry

Cross-Section Whether the wall will be vertical or slanted. Select an option 
from the drop-down list.

Structural Usage Defines the specific structural usage of a wall

Length	 Indicates the value of the length of a wall

Area Indicates the value of the surface area of a wall

Volume	 Indicates the value of the volume of a wall

Comments Specific comments that give description of a wall

Mark 	 To add a unique value or label to each wall

Phase Created Phase in which a wall is created

Phase Demolished Phase in which a wall was demolished

Image Specifies the name of the image of the wall. To specify an image 
name, click on the Value field; a Browse button will be displayed. 
Choose the Browse button; the Manage Images dialog box will 
be displayed. Use this dialog box to specify the image for the 
wall. The specified image will be displayed in the Schedule.

Specifying Type Properties 
The type properties of a wall specify the common parameters shared by certain elements in 
a family. Any changes made in the type properties of a wall element will affect all individual 
elements of that family in the project. To specify the type properties of an element, invoke the 
Wall: Architectural tool; the Modify | Place Wall tab will be displayed. In this tab, choose 
the Type Properties tool from the Properties panel; the Type Properties dialog box will be 
displayed. Using this dialog box, you can modify the type properties of the selected wall type 
such as Structure, Function, Coarse Scale Fill Pattern, and so on. 

In Autodesk Revit, in the Type Properties dialog box, you can view the analytical properties of 
the wall such as the Thermal Mass, Thermal Resistance, and Heat Transfer Coefficient. The 
analytical properties that you can edit are: Absorptance and Roughness. You can also define 
the composition of the wall type. To do so, choose the Edit button in the Value column of the 
Structure parameter; the Edit Assembly dialog box will be displayed, as shown in Figure 3-29. 
In the Edit Assembly dialog box, choose the Preview button; a preview box will be displayed. 
The preview box will display sectional detail of the selected wall type. In Autodesk Revit, a wall 
is a composite building element and can consist of several layers. The Layers area in the Edit 
Assembly dialog box displays multiple layers of the selected wall, each with a specific function, 
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material, and thickness. The layer on the top of the table represents the exterior side of a wall 
and the last layer represents the interior face. The Layers area, displays the selected wall type, 
refer to Figure 3-29. In this case, it is Exterior- Brick on Mtl. Stud. This wall type has ten layers. 
Each layer of the composite wall is assigned a specific function and priority based on its usage. 
The layers available in Autodesk Revit can be broadly classified into the categories given next.

Figure 3-29  The  Edit Assembly dialog box for a wall type

	 Structure [1]- Consists of main supporting element of the structure such as concrete, brick, 
wood, metal stud, and so on.

	 Substrate [2] - Consists of material that functions as substructure, such as foundation and 
plywood. 

	 Thermal/Air Layer - Indicates the air cavity or the thermal insulation layer.

	 Membrane Layer - A zero thickness layer primarily used for the prevention against water 
vapor penetration.

	 Finish 1 [4] - Exterior finish such as metal, brick, and stone.

	 Finish 2 [5] - Interior finish such as paint, gypsum wall board, and so on.
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Note
The numbers placed next to certain layers show the priority set of the layer and enables Autodesk 
Revit to work out the joinery detail of wall segments at corners and intersections according to the 
priority. When joined, a higher priority layer takes precedence over a lower priority layer.

In the Edit Assembly dialog box, the Material column displays the material specification, whereas 
the Thickness column displays the thickness of each layer. The total thickness of this composite 
wall is the sum of thickness of all layers. In the present case, the total thickness of wall is 1’1 
7/8” in Imperial or 350 mm in Metric which is given beside the Total thickness parameter on 
the top of the dialog box. You can click on the View drop-down list and select Section: Modify 
type attributes to view the section of the wall.

Note
The View drop-down list will only be visible if you choose the Preview button in the Edit Assembly 
dialog box.

Autodesk Revit enables you to add and remove layers by using the Insert and Delete buttons, 
respectively provided in the Layers area in the Edit Assembly dialog box. To shift the layers, 
choose the Up and Down buttons. You can also create your own layers. You will learn more about 
materials, layers, and composite walls in the later chapters. The Default Wrapping area in the 
Edit Assembly dialog box has two drop-down lists namely, At Inserts and At Ends. The options 
in these drop-down lists allow wrapping of a compound wall at the end and at the inserts (for 
doors and windows). From the At Inserts drop-down list, you can select any of the following 
options: Exterior, Interior, Both, and Do not wrap. Similarly, from the At Ends drop-down 
list, you can select any of the following options: Exterior, Interior, or None. The wrapping in 
the walls can be viewed in a plan view. After, specifying various options in the Edit Assembly 
dialog box, choose the OK button; the dialog box will close. Also, choose the OK button again 
to close the Type Properties dialog box.

Note
In the Variable column of the Edit Assembly dialog box, you can select the check box corresponding 
to a layer to make the thickness of the wall vary while you create a tapered wall.

Sketching Walls
The next step after selecting the wall type from the Properties palette is to select the sketching 
tool. Autodesk Revit provides several sketching tools, such as Line, Rectangle, and so on to 
sketch the walls of different shapes. These tools, along with the Options Bar, can be invoked 
from the Draw panel in the Modify | Place Wall tab, as shown in Figure 3-30.  

Figure 3-30  The Modify / Place Wall tab
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In the Modify | Place Wall tab, you can access different sketching tools from the Draw panel 
and the Options Bar in the Modify | Place Wall tab. On invoking these tools, you can sketch 
different wall profiles. The procedures for sketching the straight and circular wall profiles are 
discussed next.

Sketching Straight Wall Profiles
You can sketch straight walls using the Line tool by specifying the start point and the endpoint 
of the wall segment. To specify the location of the start point, click in the drawing area and move 
the cursor, you will notice that a wall segment starts from the specified point and the changing 
dimension dynamically appears on it. This dimension is called the temporary dimension or 
listening dimension, and it shows the length and angle of the wall segment at any given location 
of the cursor, as shown in Figure 3-31. 

Figure 3-31  The temporary dimensions displayed while sketching a wall

Also, notice that the cursor moves in increments by the value set in the Dimension Snaps area 
of the Snaps dialog box (See Chapter 2, Setting Snaps). The angle subtended by the wall on the 
horizontal axis is also displayed and it keeps changing dynamically as you move the cursor to 
modify the inclination of the wall. Also notice that, on bringing the cursor near the horizontal 
or the vertical axis, a dashed line will appear on the wall segment. This is called the alignment 
line and it helps you sketch the components with respect to the already created components. 
You will also notice that a tooltip is displayed indicating that the wall segment being sketched 
is horizontal or vertical.

Autodesk Revit provides you with the flexibility of specifying the length of the walls in different 
ways. The first option is to specify the starting point of the wall, move the cursor in the desired 
direction and click, when the angle and the temporary dimension attain the required values. The 
second option is to sketch the wall and then modify its length and angle to the exact value. For 
example, to sketch a 18’0” in Imperial or 5400 mm in Metric long horizontal wall after specifying 
the starting point, you can move the cursor to the right until you see a dashed horizontal line 
parallel to the sketched wall. Click when the temporary dimension shows 20’0” in Imperial or 
6000mm in Metric approximately. Note that the length of the wall may not be exactly 18’0” in 
Imperial or 5400mm in Metric. You can now use the wall controls to modify the dimensions of 
the wall to its exact value. 
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To modify the wall, select the wall segment and view its control and properties. As you select 
the wall segment, it gets highlighted in blue and the symbols appear above the wall segment. 
The exact dimension of the sketched wall is visible in the dimension text of the temporary 
dimension. The conversion control symbol, which appears below the dimension value, is used 
to convert the temporary dimension into a permanent dimension. The two blue arrows, that 
also appear on the upper face of the wall, indicate the flip control symbol for the sketched walls. 
They appear on the side interpreted as the exterior face of the wall. By default, the walls drawn 
from the left to right have the external face on the upper side and the walls drawn from the top 
to bottom have it on the right side. You can flip the orientation of the wall by clicking on the 
arrows symbol. Alternatively, you can place the cursor over the flip control symbol and notice 
the change in its color. After the color of the flip control changes, press SPACEBAR to flip the 
wall. The two blue dots that appear at the two ends of the wall segments are the drag control 
symbols. You can use them to stretch and resize the walls. To set the wall to the exact length, click 
on the temporary dimension; an edit box will appear showing the current dimension of the wall 
segment. Now, you can replace it by typing the exact length. For example, you can enter 9’ 3” 
in Imperial or 2775 mm in Metric in the edit box, as shown in Figure 3-32. Next, press ENTER; 
the length of the wall will be modified to 9’ 3” in Imperial or 2775 mm in Metric.

Figure 3-32  Entering the value of the length in the edit box

Alternatively, you can create a straight wall by typing the dimension for the length before 
choosing the endpoint. As soon as you start typing the length, an edit box appears above the 
dimension line. Enter the value of the length and press ENTER to create a wall segment of the 
specified length. To sketch a wall at a given angle, sketch it at any angle and then click on the 
angular dimension symbol; an edit box will appear. In the edit box, you can enter the exact 
angular dimension from the horizontal axis to which the wall will be inclined. 

Note
The Project Browser shows Level 1 in bold letters. This indicates that the wall has been sketched 
in that level.
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On invoking the Wall: Architectural  tool, you can set various options in the Options Bar before 
you start to sketch the wall. The options that you can specify in the Options Bar are related to 
the following options: level to which the wall height or depth will be constrained, the location 
line of the wall, the offset distance of the wall if offsetted from the specified location line, and 
the creation method of the wall. In the Options Bar, you can specify the offset distance in 
the Offset edit box. By specifying a value in this edit box, you can create a wall that starts at a 
specified offset distance from a point defined in an existing element. After entering the offset 
value and selecting the sketching option, click near the element to define the offset distance. 
When you move the cursor, the wall will start at the specified distance from the selected point. 
For example, this option can be used for creating boundary walls that are placed at a specific 
distance from the building profile. 

Also, in the Options Bar, you can select the Chain check box to ensure that you can create a 
continuous wall profile with a number of wall segments. It enables you to create a continuous 
wall with wall segments connected end to end. The end point of the previous wall becomes the 
start point to the next wall. 
  
Sketching Circular Wall Profiles
The Circle tool in the list box can be used to sketch a circular wall profile. To sketch a circular 
wall profile, invoke the Circle tool from the Draw panel of the Modify | Place Wall tab and 
click in the drawing area to specify the center point of the circular wall. You will notice that 
a circular wall profile is extending dynamically with the specified point as the center and the 
other end attached to the cursor, as shown in Figure 3-33. The temporary radial dimension will 
also be displayed. Click when the desired value for the radius is displayed. Alternatively, before 
clicking on the second point, type the value for the radius of the circular profile. As you type, 
the value will be displayed in the edit box. Press ENTER to complete the profile. Notice that the 
dimension that you entered is the distance of the center point to the location line of the profile. 
Alternatively, you can create a circular wall by specifying a value in the Radius edit box in the 
Options Bar. To do so, invoke the Circle tool from the Modify | Place Wall tab; various options 
will be displayed in the Options Bar. In the Options Bar, select the check box preceding the 
Radius edit box to activate it. In the Radius edit box, specify a value for the radius of the circle. 
Now, in the drawing window as you move the cursor, you will find the preview of the circular 
wall profile with the specified radius. Click on a specified point in the drawing area; a circular 
wall profile with the specified radius will be created.

Figure 3-33  Circular wall profile being created
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USING DOORS IN A BUILDING MODEL
A door is one of the most frequently used components in a building model. It helps in 
accessing various exterior and interior spaces in a project. Autodesk Revit provides a variety 
of predefined door types. You can access these door types by using the options from the Type 
Selector drop-down list of the Properties palette. You can also load other door types from the 
English-Imperial folder. A wall acts as a host element for doors. This means that a door can 
be placed only if there exists a wall. When you add a door to a wall, Autodesk Revit intuitively 
creates an opening in it.

In Autodesk Revit, the doors are not loaded in any of the default templates. To add doors, you 
need to add the door types to the current file. To do so, choose the Load Family tool from the 
Load from Library panel of the Insert tab; the Load Family dialog box will be displayed. In 
this dialog box, you can browse to English-Imperial >  Doors folder for Imperial or English > 
Doors folder for Metric and select the desired door type(s) from the displayed list of  families. 
After selecting the door types, choose the Open button; the Load Family dialog box will close 
and the desired door types will be added in the current project. Now, you can add the doors 
to the building model as required. The procedure for adding doors to a building model is 
described next.

Adding Doors 
You can add doors to a building model by using the Door tool. You can invoke this tool from 
the Build panel. Alternatively, you can type DR to invoke this tool. Note that in Revit, the door 
types are not loaded in the default templates. Therefore, if you are using any of the templates 
for the project and invoking the door for the first time, the Revit window displays the message 
that no doors family is loaded and prompts to  load one. To load a door family, choose the Yes 
button from the Revit window; the Load Family dialog box will be displayed. Select the desired 
family(ies) for Imperial from the English-Imperial > Doors folder or for Metric from the English 
>US> Doors folder and choose the Open button the Load Family dialog box will close and 
the Specify Types dialog box will be displayed. Select the desired type(s) from the Type area 
of the dialog box. Note that you can use the CTRL key to select multiple types from the Type 
area. After selecting the desired type choose the OK button in the Specify Types dialog box. 
The selected types of door will be loaded in the project.

Now, to add a door, invoke the Door tool from the Build panel of the Architecture tab; the 
Modify | Place Door tab will be displayed in the ribbon. In this tab, select the desired door type 
from the Type Selector drop-down list in the Properties palette. This drop-down list displays 
the door types loaded in the current project. After selecting a door type, click on the desired 
location of a wall to add the door. After adding the door to the building model, you can view 
and modify its properties. To do so, select the door; the instance properties of the door will be 
displayed in the Properties palette, as shown in Figure 3-34. 

Now, to modify the type properties of the selected door type, choose the Edit Type button 
from the Properties palette; the Type Properties dialog box for the selected door type will be 
displayed, as shown in Figure 3-35. In this dialog box, change the parameters as required and 
then choose the Preview button to view the graphical image of the selected door type.
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Figure 3-34  Partial view showing instance properties of a door

Figure 3-35  The Type properties dialog box displaying the properties of a door
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Understanding Door Properties 
The Type Properties dialog box displays the values of different parameters of a door. The type 
parameters are arranged under different heads based on their properties such as Construction, 
Materials and Finishes, Dimensions, Identity Data, and IFC Parameters. The parameters 
associated with each property are listed under each head. For example, the Dimensions head 
includes the dimensional type parameters associated with the door type such as, Height, Width, 
Trim Width, and so on. You have the option of either using the default values for these parameters 
or modifying them to the desired values. However, before modifying the type properties of a 
predefined door type, it is recommended to create a copy of the original door type and modify 
the desired properties of the new door type. The Duplicate button available on the top right 
corner in this dialog box can be used to create a copy of a door type. When you choose this 
button, the Name edit box will be displayed, prompting you to assign a name to the new door 
type. Enter a name in this edit box and choose the OK button; a new door type is created, which 
inherits the properties of the parent door type. Now, its parameters can be modified, as desired. 
Use the Rename button to give a new name to the selected door type. You can use the Load 
button, provided on the top right corner of the dialog box to load a door type of the required 
family from the additional libraries.  

Note
Renaming a door type does not alter its properties. For example, in Imperial if you rename 36”x 
84” to 34”x 84”, its width will still remain 36”, irrespective of its name. In Metric, if you rename 
0915 x 2134mm to 0860 x 2134mm, its width will still remain 0915mm.

Door Type Properties
If you change the type properties of a door, the properties of all instances of that door type in 
the project will also change. The door type properties are described in the table given next.

Parameter Name Description
Function Sets the door function value to Interior or Exterior. This value will be 

used at the time of scheduling.

Wall Closure Sets the layer wrapping for the door type.

Construction Type Describes the composition of the door.

Door Material	 Refers to the finish material of the door panel which can be selected 
from the available materials list.

Frame Material	 Refers to the finish material of the door frame and can be selected from 
the available materials list.

Height			   Sets the height of the door.

Trim Projection 
Ext

Thickness of the trim projection at the exterior side.

Trim Projection 
Int	

Thickness of the trim projection at the interior side.

Trim Width		  Width of the trim at both the sides.
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Width	 		  Width of the door can be set in this column.

Rough Width		  Used for scheduling or exporting.

Rough Height	 	 Used for scheduling or exporting.

Assembly Code		  Refers to the assembly code for the door type that can be selected from 
the hierarchical list.

 Keynote		  This is a new parameter available for all model elements, detail 
components, and materials under identity data.

Model	 		  Name to be given to the model door type.

Manufacturer		  Name of the manufacturer of the door type.

Type Comments	 Additional information or comments to be added to the door type, 
primarily for including in schedules.

URL	 		  Web link of the door type manufacturer.

Description		  Text describing the door type.

Assembly 
Description	

Text describing the assembly of the door type.

Type Mark		  Each door can be assigned a unique value that may be generated in a 
sequence of creation of the door type.

Fire Rating		  Fire rating of the door.

 Cost	 		  Cost of the door, primarily for costing purpose.

Door Instance Properties
The door instance properties, available in the Properties palette, refer to the instance properties of 
a particular door. On changing these properties, the properties of only that particular instance in 
the project is changed. The description of various instance parameters is given in the table next.

Parameter Name Description

Level Shows the layer to which the door belongs and can be used to move 
it to a different level.

Sill Height Refers to the distance or height of the sill of the door from the 
specified level. 

Frame Type Refers to the type of frame used for the door instance.

Swing Angle Refers to the swing angle of the door.

Frame Material	 Specifies the material used for the frame of the instance.

Finish Refers to the finish applied to the door and frame.

Image Specifies the name of the image for the door instance. 
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Comments	 Describes the door instance.

Mark	 Specifies the mark of the selected door.

Phase Created	 Specifies whether the door is a part of the new construction or an 
existing construction.

Phase 
Demolished 	

Specifies whether the door is a part of the existing building or a new 
structure, or none.

Head Height Refers to the height of the top of the door from the specified level.

Adding a Door to a Wall
Doors can be added to a building model in the plan, section, elevation or a 3D view, by clicking 
at the desired location in a wall. After invoking the Door tool and selecting the door type, move 
the cursor over the wall on which it is to be added. The ‘+’ symbol over the cursor indicates 
that an element is being added. You will notice that the door symbol appears, when the cursor 
is moved over the wall. When the cursor comes close to the upper or lower face of the wall, the 
door symbol appears on it, as shown in Figure 3-36. The door symbol appears on the lower face 
when the cursor comes near to that face. Also, a temporary dimension appears indicating the 
distance of the center of the door opening from adjacent walls or wall edges.

Using the temporary dimensions displayed, you can add the door at the desired location. 
Alternatively, you can first add the door at an approximate location on the wall and then modify 
its location to the exact dimension. When a door is added, an opening is automatically created 
in the wall and the edges are also completed. After selecting the door, you will notice that the 
horizontal and vertical twin arrow symbols appear in the door along with a tag number. To flip 
the swing-side of the door, click on the twin arrow key that appears parallel to the wall edge. To 
shift the door to the other side of the wall, click on the twin arrow key that appears perpendicular 
to the wall edge (vertical, in this case). To move the added door to the exact dimension, click 
on the particular temporary dimension text and enter the exact value, as shown in Figure 3-37. 
The door shifts to the desired location.

Figure 3-36  The appearance of the door symbol on the wall
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Figure 3-37  Entering the value in the edit box to position the door

Note
A door can be placed in any type of wall, regardless of the height of the door. Autodesk Revit displays 
alert messages if the door is not placed appropriately. 

In Autodesk Revit, when doors are inserted, door tags are generated automatically. They assist in 
marking the doors and later arranging them in the form of a schedule. The door type tag number 
increments sequentially, when you place a door by using the Door tool or when you copy and paste 
it into the building model. You can, however, give a specific mark or tag to doors individually. To 
add a tag to the door, ensure that the Tag on Placement button is chosen from the Tag panel of 
the Modify | Place Door contextual tab. The visibility of door tags can be controlled by using 
the Visibility/Graphics Overrides for Floor Plan dialog box. This dialog box can be invoked 
by typing VG, or by selecting the desired door from the drawing and choosing the Visibility/
Graphics tool in the Graphics panel in the View tab. Next, if you want to hide the door tags, 
choose the Annotation Categories tab from the Visibility/Graphics Overrides for Floor Plan 
dialog box and clear the Door Tags check box. When you invoke the Door tool, the option for 
adding a horizontal or vertical door tag becomes available in the Options Bar. You can set the 
orientation of the door tags to horizontal or vertical by selecting the Horizontal or Vertical 
option from the drop-down list displayed in the Options Bar.

To change a door type, select the particular instance; the properties and the type of the selected 
door will be displayed in the Properties palette. In the Properties palette, select a new door type 
from the Type Selector drop-down list; the selected door will be replaced with the new door type.

In Autodesk Revit, you can create a new door type by using various tools. To create a new door 
type, choose the Model In-place tool from the Mode panel of the Modify | Place Door tab; 
the Name dialog box will be displayed. In this dialog box, enter a name in the Name edit box 
and choose the OK button; the dialog box will be closed and the Modify tab will be displayed 
along with the various tools in the Family Editor interface. In this interface, you can use various 
tools from different tabs to create the doors that are specifically designed for that instance. After 
creating the door choose the Finish Model button from the In-Place Editor panel; the Family 
Editor interface will be closed and you will return to the Project interface. 

Note 
On invoking the Model In-place tool, the Family Editor mode will be activated. In this mode, you 
can use various massing tools from the Create tab to create an in-place door assembly. 
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Apart from the door types available in the Type Selector drop-down list, you can use other door 
types from additional libraries. To access them, choose the Load Family tool in the Mode panel 
of the Modify | Place Door; the Load Family dialog box will be displayed. Additional door 
types are available in the Doors sub folder of the English-Imperial folder. Select a door type to 
view its image in the Preview area. After selecting the door type, choose the Open button. The 
selected family of doors will be added to the Type Selector drop-down list in the Properties 
palette for that project.

ADDING WINDOWS IN A BUILDING MODEL
Windows form an integral part of any building project. Autodesk Revit provides several in-built 
window types that can be easily used and added to the building model. Like doors, windows are 
also dependent on the walls that act as their host element. In Autodesk Revit, the windows are 
not loaded in any of the default templates. To add the windows, you need to add the window 
families to the current file. To do so, choose the Load Family tool from the Load from Library 
panel of the Insert tab; the Load Family dialog box will be displayed. In this dialog box, you 
can browse to English-Imperial >  Windows folder for Imperial or English >  Windows 
folder for Metric and select the desired window type(s) from the displayed list of families. After 
selecting the window families, choose the Open button; the Load Family dialog box will close 
and the Specify Types dialog box will be displayed. Select the desired type(s) from the Type 
area of the dialog box. Note that you can use the CTRL key to select multiple types from the 
Type area. After selecting the desired type choose the OK button in the Specify Types dialog 
box and the desired window types will be added in the current project. Now, you can add the 
window to the building model as required. The procedure for adding windows to a building 
model is described next.

Adding Windows 
In Autodesk Revit, you can add windows to a building model by using the Window tool. To 
do so, invoke the Window tool from the Build panel of the Architecture tab; the Modify | 
Place Window tab will be displayed. In this tab, select the window type from the Type Selector 
drop-down list in the Properties palette. To add a window to a building model, move the cursor 
over the wall and click to place it either in the upper face or in the lower face. After adding 
the window, you can view and also change its instance parameters. To do so, select the window 
from the drawing; the Properties palette will be displayed. You can use this palette to view and 
modify various instance parameters of the selected window such as its Level, Head Height, Sill 
Height and others. To modify and view the type parameters of the window, choose the Edit 
Type button in the Properties palette; the Type Properties dialog box will be displayed. In this 
dialog box, choose the Preview button to view the graphical image of the selected window type. 

Understanding Window Properties 
The Type Properties dialog box displays the type parameters for different components of a 
window such as Glass Pane Material, Sash Material, Default Sill Height, Width, Height, and 
so on. You can click in the value column of each parameter and select the required options 
or use the Load button provided on the top right corner of the dialog box to load a window 
family type from the additional libraries. The Duplicate button can be used to create a copy of 
the window type with a different name. The new window inherits the properties of the parent 
window type and its parameters can be modified as desired. By using the Rename button, you 
can give a new name to the selected window type.
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Window Type Properties
When you change the type properties of a window type, the properties of all instances of that 
window type in the project will also change. Various type parameters and their corresponding 
descriptions are given in the following table:

Parameter Name Description

Wall Closure Sets layer wrapping for the window type

Construction Type Describes the composition of the window

Glass Pane Material Refers to the finish and material of the glass pane and can be 
selected from the available materials list

Sash Material Refers to the material assigned to the sash of the window

Trim Exterior Material Sets the exterior trim material

Trim Interior Material Sets the interior trim material

Height	 The value used to set the height of the window

Default Sill Height Distance of the window from the bottom of the wall, the default 
value is 	3’0” in Imperial or 915.0 mm for Metric

Trim Projection - Ext. The value used to set the exterior projection

Trim Projection - Int. The value used to set the interior projection

Trim Width - Exterior The value used to set the width of exterior projection

Trim Width - Interior The value used to set the width of interior projection

Width	 Refers to the width of the window

Window Inset Refers to the inset of the window from the wall face

Rough Width The value used for scheduling or exporting 

Rough Height	 Used for scheduling or exporting 

Keynote This is a new parameter available for all model elements, detail 
components, and materials under identity data

Model	 Name to be given to the window type

Manufacturer	 Name of the manufacturer of the window type

Type Comments Additional information or comments to be added to the window 
type, primarily for creating schedules

URL Weblink of the manufacturer

Description Text describing the window type

Assembly Description Text describing the assembly

Type Mark Unique value assigned to each window

Cost Cost of the window, primarily for costing purpose



Creating Building Envelopes			   3-47

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Window Instance Properties
Changing the instance properties of a window, changes the properties of only that instance of 
the window in the project. The instance properties of a window are given in the table given next.

Parameter Name Description

Level	 Shows the layer to which the window belongs and can be used to 
move the window to a different level

Sill Height Refers to the distance or height of the sill of the window from the 
specified level

Image Specifies the name of the image of the window type. The specified 
image will be displayed in the Schedule.

Comments Description of the window instance not covered in the type 
properties

Mark Can be used to specify or modify the mark of the selected window

Phase Created Specifies whether the window is part of a new construction or an 
existing construction

Phase Demolished Specifies whether the window is a part of demolished structure

Head Height Refers to the height of the top of the window from the specified level

Note that the properties available in the Type Properties dialog box may vary depending on the 
type of window you will select from the Type Selector drop-down list in the Properties palette.

Adding a Window to a Wall
To add a window to a wall, invoke the Window tool from the Architecture tab of the ribbon and 
select the window type from the Type Selector drop-down list in the Properties palette. Next, 
move the cursor close to the wall on which it needs to be added. The window symbol appears 
when the cursor is moved over the wall. When the cursor comes close to the lower face of the 
wall, the window appears on that face. The window appears on the upper face when the cursor 
comes near to it, as shown in Figure 3-38. Also, notice a temporary dimension, which indicates 
the distance of the center of the window opening from the adjacent walls or wall edges. You can 
also use the temporary dimensions to add the window by clicking at the appropriate location 
on the wall. Autodesk Revit automatically creates an opening in the wall and the edges are also 
completed.
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Figure 3-38  The appearance of the window symbol on the wall

You will also notice a twin arrow symbol on the window, along with a tag number. Click on the 
symbol to flip the orientation of the window. The flip arrow symbol will appear on the side that 
is interpreted as the inner side of the window. You can specify the exact position of the window 
with respect to the adjacent walls or edges after placing it at the approximate location. To 
specify the dimensional location of a window, click on the particular temporary dimension text 
and type the exact dimension. The window will shift to the desired location. Window tags are 
automatically generated in Autodesk Revit. Unlike doors, however, each window of the same 
type bears the same tag. Different window types have preassigned marks, which can be changed 
using the Type Properties dialog box. Window tags are used for creating the window schedule.

Note
The window tag numbers increases as you place or copy them in the project. You can also give 
them a specific tag number individually. 

Similar to the door tags, the visibility of the window tags can also be controlled in the drawing. 
To hide the window tags, invoke the Visibility/Graphics for Floor Plan dialog box and choose 
the Annotation Categories tab from it. Next, clear the Window Tags check box.  

Note
On clearing the Window Tags check box in the Annotation Categories area of the 
Visibility/Graphics for Floor Plan dialog box, the tags become hidden but still remain a part 
of the project. 

In Autodesk Revit, you can create the windows that are specifically designed for a location or an 
instance. To do so, choose the Model In-place tool from the Mode panel of the Modify |Place 
Window tab; the Name dialog box will be displayed. In this dialog box, enter the name of the 
window type in the Name edit box and choose the OK button; the dialog box will be closed and 
the Modify tab will be displayed. Now, the Family Editor mode will be activated, and in this mode, 
you can use various tools to create the in-place window. Apart from the window types displayed 
in the Type Selector drop-down list, you can access other window types as well. To add other 
window types in the Type Selector drop-down list, choose the Load Family tool from the Mode 
panel of the Modify | Place Window tab; the Load Family dialog box will be displayed. In this 
dialog box, add additional window types from the Library > English-Imperial > Windows 
folder for Imperial or Library > English > US> Windows folder for Metric.
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DOORS AND WINDOWS AS WALL OPENINGS
Autodesk Revit also provides in-built opening types for door and windows. These types are 
available in the Openings subfolder of the Libraries > English-Imperial folder for Imperial 
or the Openings subfolder of the Libraries > English folder for Metric that can be accessed 
from the Load Family dialog box. To invoke this dialog box, choose the Load Family tool from 
the Load from Library panel of the Insert tab.

To add an opening for door, invoke the Load Family dialog box and then from the Openings 
subfolder select any of the following family types: Passage Opening-Cased or Passage 
Opening-Elliptical Arch. After selecting any of the family type, choose the Open button in 
the Load Family dialog box; the selected family will be loaded in the project. Now, to place the 
selected opening type in the wall, choose the Place a Component tool from Architecture > 
Build > Component drop-down; the Modify | Place Component tab will be displayed. In 
the Properties palette, ensure that the desired opening type is selected in the Type Selector 
drop-down list. Next, click in a desired location in the wall to insert the door opening. In the 
Properties palette, you can also edit the width and height of the door opening.

Similar to adding a door opening, you can insert a window opening. To do so, invoke the Load 
Family dialog box and then select any of the two family types from the Openings subfolder: 
Opening with Trim or Opening. To place the window opening in the wall you will follow the 
same method as used for inserting the door opening.     

OPENINGS IN THE WALL
You can create rectangular openings in a curved or straight wall. To cut an opening in a wall, you 
can use a plan, elevation, or sectional view. Generally, the sectional or elevation view is preferred 
as locating and placing such views is easy. To cut a rectangular opening in a wall, open a preferred 
elevation or a section view in which the host wall of the opening is visible. Next, choose the 
Wall: Architectural tool from the Opening panel of the Architecture tab and then select the 
wall that will host the opening. Click in the desired area in the wall to mark the start point or 
the first corner point of the rectangular opening. As you move the cursor, a rectangle with its 
temporary dimensions appears. Click at the desired point in the wall to mark the other corner 
point of the rectangular opening. Now, you can use the temporary dimensions displayed on 
the opening to modify the placement of the opening. Next, choose the Modify button from the 
Select panel to exit the tool. After exiting the tool, you can select the created opening to modify 
its properties such as its height, top offset, base offset, and so on from the Properties palette.

CREATING ARCHITECTURAL FLOORS	
You can add a floor to the current level of a building model using the Floor: Architectural 
tool. You can invoke this tool from the Build panel of the Architecture tab. On invoking this 
tool, the Modify | Create Floor Boundary tab will be displayed. You can use this tab to draw, 
annotate, and edit a floor boundary for your building model as well as to assign properties to 
them. The Draw panel of the Modify | Create Floor Boundary tab consists of various tools 
that are used to draw the floor sketches. These sketches define the boundary of the floor. To 
define the boundary of the floor, you can either pick the existing walls or sketch the boundary 
in the plan view by using lines. You can also sketch the boundary in the 3D view, provided that 
the work plane is set to the plan view. 
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Similar to other model components, the floor tool has associated type and instance properties. 
Once you sketch the floor, the Properties palette will display the instance parameters of floor. 
The Type Selector drop-down list in this palette displays the floors available in Autodesk Revit’s 
library. This palette can be used to modify the instance properties of the floor such as the level 
at which the floor is to be created, the height offset of the floor from the specified level, and so 
on. To modify the type properties of a floor, choose the Edit Type button from the Properties 
palette; the Type Properties dialog box will be displayed, as shown in Figure 3-39. 

             Figure 3-39  The Type Properties dialog box 

You can set the type parameters for the floor in it. You can also create a new floor type by using 
the Duplicate button. To edit the structural elements of the floor, choose the Edit button in the 
Value column for the Structure type parameter; the Edit Assembly dialog box will be displayed, 
showing the structure of the floor type with its different layers. In the Edit Assembly dialog box, 
the Insert or Delete button can be used to customize the new floor type based on the specific 
project requirement.  

Note
The type and instance properties may vary depending on the floor type selected. Autodesk Revit Help 
provides a detailed explanation of all properties associated with floor types.
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Sketching the Floor Boundary
To create a floor, you need to sketch its boundary. There are two methods to sketch a boundary. 
The first method is to pick the already created walls using the Pick Walls tool to define the 
floor boundary. The other method is to draw the floor profile using the draw tools such as 
line, rectangle, polygon, arc, and others from the Draw panel of the Modify | Create Floor 
Boundary tab.

By default, the Pick Walls tool is chosen in the Draw panel of the Modify | Create Floor 
Boundary tab. This tool can be used to sketch the floor for the spaces bound by the connected 
walls. The Option Bar displays the Offset edit box, which can be used to specify the offset distance 
of the floor sketch line from an existing wall. The Extend into wall (to core) check box is used 
to extend the floor to the wall core and assists in creating a joint between the floor and the wall 
core. If the Pick Walls tool is not chosen by default, then invoke this tool and move the cursor 
near to the wall. You will notice that as the cursor is brought near to the face of the wall, a dashed 
line appears along with its inner or outer face. You can choose either of the faces of the wall to 
sketch the floor. Click when the dashed line appears at the appropriate location; a magenta line 
with flip and drag controls as well as two parallel lines will be displayed on the wall, as shown 
in Figure 3-40. The flip control can be used to flip the line between the two faces of the wall.

Figure 3-40  The line with flip and drag control representing an edge of the floor is displayed

Similarly, you can select other walls to define the floor boundary. The sketched boundary must 
form a closed profile with all edges connected to each other. After completing the floor boundary, 
you can edit it by using the drag controls and various tools in the Modify panel of the Modify | 
Create Floor Boundary tab.  After the floor profile has been sketched, choose the Finish Edit 
Mode button from the Mode panel; the floor will be created, as shown in Figure 3-41. As the 
floor created will not be visible in the plan view, you can use the Default 3D View tool from the 
View tab to view it.
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Figure 3-41  The created floor boundary

The other option to sketch the floor profile is to draw it using the sketching tools from the Draw 
panel. You can choose the appropriate sketching tool to sketch the floor boundary based on its 
shape. The functions of the sketching tools are the same as those used for creating a wall. While 
using the Line tool, you can select the Chain check box in the Options Bar to sketch the lines 
that are connected end-to-end. Also, you can specify the value in the Offset edit box in the 
Options Bar to sketch lines at a specified offset distance from a point on an existing element. 
Using the editing tools in the Modify panel of the Modify | Create Floor Boundary tab, you 
can edit the sketched profile. 

In the sketched floor boundary, you can provide slope. To do so, invoke the Slope Arrow tool from 
the Draw panel; a list box containing tools to draw the slope arrow will be displayed. The list box 
contains two tools: Line and Pick Lines. The Line tool in the display panel is chosen by default. 
You need to specify the start point and endpoint of the arrow in the drawing. After specifying 
the start point and endpoint, you can modify its instance properties in the Properties palette. 
Using this palette, you can modify the associated properties such as specification method to 
define the slope arrow, the level at which the tail of the slope arrow will rest, height offset at 
the tail of the arrow, and more. You can attain the desired slope in the floor using the instance 
properties in the Properties palette.

After you complete the profile and add specifications for the floor, choose the Finish Edit 
Mode button from the Mode panel; the floor will be created and the Modify | Floors tab will 
be displayed. In this tab, you can use various modification tools to modify the floor created. 
This tab consists of nine panels: Properties, Clipboard, Geometry, View, Dimension, Create, 
Modify, Mode, and Shape Editing. 

PLACING CEILINGS
You can add a ceiling to a building model by using the Ceiling tool. To do so, invoke this tool 
from the Build panel in the Architecture tab; the Modify | Place Ceiling tab with various tools 
for creating the ceiling will be displayed. Since the ceilings are not visible in the floor plan,  they 
are created in the ceiling plan head of each discipline. You can add a ceiling to a project using 
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three different methods, by adding automatic ceiling, by sketching the ceiling, and by using 
the pick walls method.

Creating an Automatic Ceiling
The first method to add a ceiling to a project is by creating an automatic ceiling. To do so, choose 
the Ceiling tool from Build panel in the Architecture tab; the Modify | Place Ceiling tab will 
be displayed. In this tab, choose the Automatic Ceiling tool from the Ceiling panel. In the 
Properties palette, select the ceiling type from the Type Selector drop-down list. You can select 
different types of built-in ceiling that can be used from this list. Now, to add the ceiling to the 
entire room, open the ceiling plan, move the cursor inside the room, and click when the ceiling 
boundary is displayed. Autodesk Revit will automatically create the ceiling from the center of 
the room. For example, when you move the cursor inside the room for creating an automatic 
ceiling, its boundary is highlighted in red, as shown in Figure 3-42. Click to create the ceiling, 
automatically. If you have created the ceiling in a floor plan, Autodesk Revit will display a warning 
indicating that the ceiling created will not be visible in it. You can then open the ceiling plan of 
the corresponding level to view the created ceiling. You can also open the section view through 
the room to view the cross-section of the ceiling.

Figure 3-42  The highlighted ceiling boundary

Sketching a Ceiling
You can sketch a ceiling boundary to create it. To do so, choose the Ceiling tool from the Build 
panel; the Modify | Place Ceiling tab will be displayed. In this tab, choose the Sketch Ceiling 
tool from the Ceiling panel; the Modify | Create Ceiling Boundary tab will be displayed. This 
tab contains various tools for sketching and modifying the ceiling boundary. To start the sketch of 
the ceiling boundary, choose the Boundary Line tool from the Draw panel; a list box containing 
various drawing tools will be displayed on the right in this panel, as shown in Figure 3-43.

Figure 3-43  Different sketching tools for ceiling
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The Line tool is chosen by default in the Draw panel. You can use this tool and the other drawing 
and modification tools displayed in the Modify | Create Ceiling Boundary tab to complete the 
sketch. Figure 3-44 shows a ceiling boundary that is sketched using various tools displayed in 
the Modify | Create Ceiling Boundary tab. 

Figure 3-44  The sketched ceiling boundary 

After completing the sketch, choose the Finish Edit Mode button from the Mode panel of the 
Modify | Create Ceiling Boundary tab; the ceiling will be created within the sketched profile. 
Display the section view to view the ceiling in it. The ceiling will appear at a certain height from 
the floor level, as shown in Figure 3-45.

Figure 3-45  The three dimensional view displaying the ceiling at a height

Using the Pick Walls Method
The third method to create the ceiling is by picking the wall faces. This is a common method 
for creating ceilings. To do so, choose the Ceiling tool from the  Architecture tab; the Modify 
| Place Ceiling tab will be displayed. In this tab, choose the Sketch Ceiling tool from the 
Ceiling panel; the Modify | Create Ceiling Boundary tab will be displayed. In this tab, choose 
the Pick Walls tool from the list box of the Draw panel; you will be prompted to pick the walls 
to define the boundary of the ceiling. Specify the offset value for the ceiling in the Offset edit 
box in the Options Bar. Select the Extend into Wall (to core) check box, if you want the offset 
to be measured from the core layer of the walls. Next, pick the walls to create the sketch for the 
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ceiling. In the Properties palette, select the ceiling type from the Type Selector drop-down 
list. Next, choose the Finish Edit Mode button from the Mode panel of the Modify | Create 
Ceiling Boundary tab; the ceiling will be created.

Modifying a Ceiling
You can modify a ceiling after it has been created. To modify the ceiling, select it; the Modify | 
Ceiling tab will be displayed. From this tab, you can use various modification and editing tools to 
make changes on the selected ceiling. To edit the selected ceiling, you can use the editing tools 
such as Copy, Rotate, Move, and Mirror. You can also modify the properties of the selected 
ceiling based on its sketch. To do so, choose the Edit Boundary tool from the Mode panel; the 
Modify | Ceiling > Edit Boundary tab will be displayed and the sketch mode will be activated 
for the selected ceiling in the drawing. Now, you can modify the sketch profile by using the 
drag controls and other editing tools. Select the edge(s) of the ceiling boundary; the instance 
properties for the selected edges(s) of the ceiling profile will be displayed in the Properties 
palette. In this palette, you can enter the required values of various instance parameters for the 
selected edge(s) of the ceiling boundary.

You can view and edit the instance properties of a ceiling. To do so, select the ceiling from the 
drawing; the instance properties of the ceiling will be displayed in the Properties palette.  This 
palette displays the instance parameters of the selected ceiling such as the level, height offset 
from level, and so on.

Being a level-based element, ceilings are created at a specified distance from the base level. 
This distance is specified in the Height Offset From Level instance parameter in the Properties 
palette. For example, to create a ceiling of 10’ height for Imperial or 3000mm for Metric from 
Level 2, you can select it as the value for the Level instance parameter and enter the value 10’ 
for Imperial or 3000mm for Metric in the Height Offset From Level instance parameter. 

The Edit Type button in the Properties palette is used to invoke the Type Properties dialog 
box. Choose the Edit Type button; the Type Properties dialog box for the selected ceiling type 
will be displayed. In the Type Properties dialog box, you can create a duplicate type to create a 
new ceiling type. To do so, choose the Duplicate button; the Name dialog box will be displayed. 
In this dialog box, enter a name for the new ceiling type in the Name edit box and choose OK; 
the Name dialog box will close and new type of ceiling will be created. In the Type Properties 
dialog box, choose the Edit button in the Value column for the Structure type parameter to 
display the Edit Assembly dialog box. This dialog box displays the structure of the ceiling type 
with its various layers. The Insert or Delete button can be used to customize the new ceiling 
type, based on the specific project requirement.

Note
When you select the created ceiling in the section view and choose the Edit button, Autodesk Revit 
displays the Go To View dialog box. You can select the view that you want to open for editing the 
ceiling boundary sketch.

CREATING ROOMS
Room is a part of Revit building elements. Revit provides you the flexibility of creating rooms 
independent of room tags. Rooms can be created only in the plan view. You can also add rooms 
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from the room schedules. Rooms and areas have the same graphical representation. Also, Revit 
forms the basis for creating spaces. 

Adding Rooms                                                                                                                                           
You can add rooms in the plan view of a specified discipline by using the Room tool. To do so, 
invoke this tool from the Room & Area panel, as shown in Figure 3-46; the Modify | Place 
Room tab will be displayed. Now, move the cursor inside the closed boundary that you need to 
define as room in the drawing; a symbol with a cross hair graphics attached to the cursor will 
appear. Notice that the size of this cross hair graphics will change according to the area of the 
room space of the closed boundary. Before you insert the room, you can select the type of room 
from the Type Selector drop-down list in the Properties palette. You can select any of the three 
options: Room Tag, Room Tag With Area, and Room Tag With Volume from the Type-Selector 
drop-down list. You can select the Room Tag option to display the inserted room with the tag 
only. Similarly, you can select the Room Tag With Area or Room Tag With Volume option from 
the Type Selector drop-down list to attach the room tag to the room to display the information 
regarding the area or volume of the room. After selecting the required option from the Type 
Selector drop-down list, choose the Highlight Boundaries tool from the Room panel of the 
Modify | Place Room tab; the Autodesk Revit 2022 message box will be displayed informing 
that the room bounding elements are highlighted in the drawing. Choose the Close button to 
close the message box.

Figure 3-46  Invoking the Room tool

To add a room with a room tag, choose the Tag on Placement tool from the Tag panel. You 
can specify the level up to which the boundary of a room will extend vertically or in upward 
direction. To do so, select an option from the Upper Limit drop-down list in the Options Bar. 
For example, if you have added a room to the floor plan of Level 1 and you desire to extend 
the room to Level 2, select the Level 2 option from the Upper Limit drop-down list. You can 
extend the room boundary above the level specified in the Upper Limit drop-down list. To do 
so, click in the Offset edit box in the Options Bar. The default value displayed in this edit box 
is 10’ for Imperial or 3000mm for Metric. You can enter a positive value to extend the room 
boundary above the level that you have selected from the Upper Limit drop-down list. Similarly, 
you can enter a negative value to extend the room boundary below the selected level. You can 
orient the room tag horizontally or vertically with reference to the current view, or align it with 
the walls and boundary lines present in the building model. To specify the orientation of the 
room tag, select an option from the drop-down list displayed next to the Offset edit box in the 
Options Bar. You can select the Leader check box to place the room tag with a leader. 
     
To add a room, click in an area enclosed by the room bounding elements such as walls, as 
shown in Figure 3-47. The room will be added and the area of the room will be equal to the 
area enclosed by the walls.
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Figure 3-47  The graphical representation of the room

You can also add a room in a free space or in an area that is not enclosed completely, and then 
add walls or other room bounding elements to the room. In such an instance, the room will 
be created and the area of the room will be equal to the area enclosed by the walls added later. 
Figure 3-48 shows a room added to the area that is not enclosed and Figure 3-49 shows the room 
added after enclosing the area by adding a wall segment. On placing a room in a free space or 
in an area that is not enclosed, Revit will display a warning message that the room is not in a 
properly enclosed region.

Figure 3-48  Room added in an open boundary
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Figure 3-49  Room created after adding the wall

Creating Rooms from Room Schedules
Revit provides you with the flexibility to add rooms from the room schedules. You can add a 
new room in a room schedule and place the same room in the plan view. To do so, invoke the 
Room tool and select the room type from the Room drop-down list in the Options Bar. Next, 
select the room tag from the Type Selector drop-down list. The room types will be available in 
the Room drop-down list only when you have added rooms in a room schedule. After selecting 
the room type from the drop-down list, click in the drawing to place the room; the room will be 
added with a room tag in the drawing.

 Note
If you do not select the room type from the Room drop-down list in the Options Bar, a new room 
will be created and numbered after the last number of the room in the schedule.

Room Bounding Elements
You can use different elements as room bounding elements. These elements define the boundary 
of the room and help in calculating the area and volume of the room. Walls, roofs, ceilings, 
curtain systems, floors, columns, and room separation lines can be used as room bounding 
elements. Revit calculates the area based on the area enclosed by room bounding elements and 
the room height.

Modifying Room Properties
You can modify the room properties by changing the values of the room parameters in the 
Properties palette. To do so, select the room and click when the crosshair graphics is displayed; 
the Properties palette will be displayed, as shown in Figure 3-50.  
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Figure 3-50  The Properties palette displaying 
the properties of room

Understanding Room Instance Parameters
The different instance parameters of a room are described in the table given next.  
 

Instance Parameter	
                     

Value and Description

Level	 Refers to the base level of the room. Level 1 is the default value.

Upper Limit Refers to the upper boundary of the room. The specified level 
the value defines the upper limit of the room. You can select 
the level from the Level drop-down list.

Limit Offset Refers to the value specified to be added in the level to set 
the total height of the room. This parameter can also have 
negative value.

Area Refers to the total area calculated using the room bounding 
elements.

Perimeter Refers to the perimeter of the room.
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Unbounded Height Total height defined by the sum of the room base level, upper 
limit and the limit offset.

Volume Refers to the total volume of the room. The volume is computed  
only when you select the Areas and Volumes radio button in 
the Area and Volume Computations  dialog box.

Number Refers to the room number assigned according to the number 
of rooms added.

Name Refers to the room name. The default name is Room. You can 
assign any name to the room. 

Comments You can enter some specific comments or description about 
the room.

Occupancy Refers to the type of occupancy for structure. You can specify 
occupancy as per the requirement. You can define any name  
for this parameter.

Base/Ceiling Finish It is a user-defined parameter. In this parameter, you can define any 
type of finish for the base and the ceiling such as GWB.

Wall/Floor Finish Refers to the finish for the walls of the room such as metal paints
 and coatings of the walls and tiles for the floor.

Occupant Refers to the name of the occupant.

Phase Refers to the name of the phase in which the room is created.

Calculating Room Volumes
To enable the room volume computations, choose the Area and Volume Computations  tool from 
the Room & Area panel; the Area and Volume Computations dialog box will be displayed. In 
the Volume Computations area of the Computations tab, select the Areas and Volumes radio 
button. By default, the Areas only radio button is selected in the Volume Computations area. 
Next, choose the OK button; the volume computation of the room will be enabled and displayed 
in its instance properties. To view the computed volume of a room, select it from the drawing; 
the Properties palette will be displayed. In the Properties palette, the  value in the value column 
of the Volume parameter shows the computed volume of the room.

Note 
In Revit, the volume calculations of the room are done considering the finish face of the 
room-bounding element. When you select a room, the outline and the color fill display the exact 
periphery and the enclosed area used for calculating the volume of the room.

While computing the room volume, the room volume calculation engine of Autodesk Revit looks 
up and down from the measurement height to access the vertical limit of the room-bounding 
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element. You can set the lower and upper limits of the room bounding elements using the 
Properties palette. The Base Offset parameter in the value column in this palette defines the 
limit of the lower boundary. It is used to limit the extent of the room with no floors or prevent 
floors to leak from floor openings while computing the volume of the room. The volume is also 
displayed in the drawing view if the rooms are added in the drawing view with the Room Tag 
With Volume option selected from the Type Selector drop-down list.

CUTTING OPENINGS IN A WALL, FLOOR, AND CEILING 
In Autodesk Revit, you can create an opening in the wall, floor, structural floor, ceiling, and 
structural elements such as beams and braces. To do so, invoke any of the tools from the Opening 
panel of the Architecture tab, as shown in Figure 3-51. From this panel, you can choose any of 
these five options, By Face, Wall, Vertical, Shaft, or Dormer to create an opening. In Revit, to 
create openings, you need to change the Discipline parameter of view to Architecture. 

Figure 3-51  The tools in the Opening panel

Creating Openings Using the By Face Tool
You can use the By Face tool to create openings on the faces of floors, or ceilings in the 
building model. This tool is useful in a project when you need to cut an opening in a 
floor for stairway and in the ceiling for a chimney. To do so, invoke this tool from the 
Opening panel; you will be prompted to select a planar face of required floor, ceiling, 
beam, or column. Select the face on which you want to create the opening; the Modify 

| Create Opening Boundary tab will be displayed. In this tab, you can use various tools to sketch 
the opening in desired view. Now, open the required view and sketch the opening using the 
reference planes, as shown in Figure 3-52. After sketching the opening boundary on the selected 
face, choose the Finish Edit Mode button from the Mode panel to finish the sketch of the 
opening and then exit the Modify | Create Opening Boundary tab. Figure 3-53 shows the 
opening created perpendicular to the selected face.  

Figure 3-52  Sketching the opening in the 
ceiling plan using the reference planes

Figure 3-53  Opening created perpendicular to 
the selected face
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Creating Openings Using the Vertical Tool
To cut a vertical opening, choose the Vertical tool from the Opening panel and 
select the required ceiling, or floor; the Modify | Create Opening Boundary tab 

will be displayed. You can use various tools from this tab to sketch the boundary of the opening. 
Sketch the opening in the appropriate view using the sketching tools. After sketching the opening 
boundary, choose the Finish Edit Mode button from the Mode panel; a vertical opening will 
be created in the selected element. You can use the sketching tools to draw a sketch of appropriate 
size, as shown in Figure 3-54. The opening can also be viewed in the 3D view, as shown in 
Figure 3-55.

Figure 3-54  Sketching the opening in the 
ceiling plan view

      Figure 3-55  3D view of the opening in ceiling

Creating Openings Using the Wall Tool
To create a rectangular opening in a wall, choose the Wall tool from the Opening 
panel in the MEP tab; you will be prompted to select a wall. Select the wall in 

which you want to cut an opening and then sketch a rectangular opening of the required size 
by clicking and dragging the cursor. 

Creating Openings Using the Dormer Tool
To create a dormer opening in the dormer roof, choose the Dormer tool from the 
Opening panel; you will be prompted to select the roof in which you want to create 

a dormer opening. Select the roof; the screen will enter the sketch mode. Choose the Pick Roof/ 
Wall Edges tool from the Pick panel of the Modify | Edit Sketch tab and pick the boundary of 
the dormer to create the dormer opening. Next, choose the Finish Edit Mode button from the 
Mode panel; a dormer opening will be created.   

Note
The boundary that you will pick for the dormer opening in a roof should be an edge of the selected 
roof, wall, or both, and should form a closed loop.
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Creating Openings Using the Shaft Tool
To cut an opening up to the entire height of a building, choose the Shaft tool from the Opening 
panel; the Modify | Create Shaft Opening Sketch tab will be displayed. Choose a suitable 
sketching tool from this tab to create an opening of the required shape. Next, choose the Finish 
Edit Mode button from the Mode panel; the opening will be created passing through the entire 
height of the building. Make sure that before sketching the opening, you select the required 
work plane and the view to sketch the opening.

You can also specify the levels that will be cut by the opening. It will help you to restrict the opening 
to a particular level. To specify the levels, select the opening; the Modify | Shaft Openings tab 
will be displayed. Select a level for the Base Constraint parameter in the Properties palette to 
start the opening. Next, select a level for the Top Constraint parameter to end the opening. 
The opening will be cut through the selected levels.

TUTORIALS
Tutorial 1					                      Office Building I

In this tutorial, you will create the exterior and interior walls, add grids, and modify levels in 
office building based on the sketch plan shown in Figure 3-56. The dimensions have been given 
only for reference and are not to be used in this tutorial. The project file and the parameters to 
be used for creating the walls and for adding grids and modifying levels are given next.
								          (Expected time: 30 min)
1.	 Project file-
			   For Imperial	 Systems Default
			   For Metric	 Systems-Default_Metric
2.	 Exterior Wall type-
			   For Imperial	  Generic- 9”.
			   For Metric	  Generic- 230mm.
3.	 Interior Wall type-
			   For Imperial	  Generic - 5”.	
			   For Metric	  Generic - 90mm.
4.	 Location line parameter- Wall Centerline; Top Constraint- Up to Level 2.
5.	 Rename Level 1 as the Ground Floor
6.	 Grids to be created in the plan view.
7.	 File name to be assigned:
			   For Imperial	 c03_Office_BuildingI_tut1.rvt	
			   For Metric	 M_c03_Office_BuildingI_tut1.rvt	

	 The following steps are required to complete this tutorial:

a.	 Open the required template file.
			   For Imperial	 Systems Default
			   For Metric	 Systems-Default_Metric
b.	 Invoke the Wall: Architectural tool from the ribbon.
c.	 Select the required exterior wall type from the Properties palette.
			   For Imperial	 Generic- 9” 
			   For Metric	 Generic- 230mm
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d.	 Select the required interior wall type from the Properties palette.
			   For Imperial	 Generic- 5” 
			   For Metric	 Generic- 90mm
e.	 Modify Top Constraint- Up to Level: Level 2 and Location Line - Wall Centerline as wall 

properties using the Properties palette, refer to Figure 3-57.
f.	 Invoke the Rectangle tool and then sketch the exterior walls based on the given parameters, 

refer to Figures 3-58 through 3-63.
g.	 Sketch the interior walls based on the given parameters, refer to Figures 3-63 through 3-69.
h.	 Modify levels by renaming them, refer to Figure 3-70.
i.	 Add grids using the Grid tool, refer to Figures 3-71 through 3-73.
j.	 Save and close the project.

Figure 3-56  Sketch plan for creating exterior walls for the Office Building

Opening a New Project and Using the Template File 
1.	 Choose New > Project from the File menu; the New Project dialog box is displayed.

2.	 In the New Project dialog box, choose the Browse button and then select the following 
template:

			   For Imperial	 Systems-Default
			   For Metric	 Systems-Default_Metric

	 Next, choose the Open button and then the OK button; the desired template file is loaded.
	 Notice that the Project Browser now shows several views that are preloaded in the template 

file.

3.	 In the Project Browser, select 1-Mech under the Mechanical head, if it is not selected 
by default and right-click to display a flyout. From this flyout, choose Duplicate View > 
Duplicate; 1 - Mech Copy 1 is displayed under the Mechanical head.

4.	 Double click on 1 - Mech Copy 1 to display the corresponding view. Now, in the Properties 
palette, click on the value field corresponding to the Discipline parameter. Select the 
Architectural discipline from the drop-down list and choose the Apply button to apply the 
changes.
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5.	 Now, the Architectural head is added under the Views (Discipline) in the Project Browser 
and under that head, 1 - Mech Copy 1 is displayed.

6.	 Select the 1 - Mech Copy 1 under the Architectural Plan head and right-click to display a 
flyout. From the flyout, choose the Rename option; the edit box is displayed. Enter Level 1 
in the edit box and choose the OK button; the dialog box is closed and the view is renamed 
to Level 1.

7.	 Repeat the procedure followed in steps 3 through 6 to

Figure 3-57  The Properties palette 
displaying other views under the 
Elevations sub-head

 
duplicate another level as Level 2 from Mechanical 
head into Architectural head, as shown in Figure 3-57. 

8.	 In the Project Browser, select East-Mech under the 
Mechanical head and Elevations sub-head of the 
Mechanical head and right-click to display a flyout. 
From this flyout, choose Duplicate View > Duplicate; 
East - Mech Copy 1 is displayed under the Elevations 
sub-head in the Mechanical head.

9.	 Double-click on East - Mech Copy 1 to display the 
corresponding view. Now, in the Properties palette, 
click on the value field corresponding to the Discipline 
parameter. Select the Architectural discipline from the 
drop-down list and choose the Apply button to apply 
the change.

10.	 Now, in the Project Browser window, East - Mech 
Copy 1 is displayed under the Views (Discipline) > 
Architectural > Elevations (Building Elevation).

11.	 Select East - Mech Copy 1 under the Architectural 
Plan head and right-click to display a flyout. From the flyout, choose the Rename option; 
the edit box is displayed. Enter East - Archi in the edit box and choose the OK button; the 
dialog box is closed and the view is renamed to East - Archi.

12.	 Repeat the procedure followed in steps 8 through 10 to add other views under the Elevations 
sub-head, refer to Figure 3-57. 

Invoking the Wall: Architectural Tool and Selecting the Wall Type
	 In this section, you will sketch an architectural wall using the Wall tool. 

1.	 Double-click on the Level 1 view under the Views (Discipline) > Architectural > HVAC > 
Floor Plans; the corresponding view is displayed.

2.	 Invoke the Wall: Architectural tool from the Architecture > Build > Wall drop-down; the 
Modify | Place Wall tab is displayed.

3.	 In the Type Selector drop-down list of the Properties palette, select the Generic - 8” wall 
type for Imperial or Generic - 200mm wall type for Metric unit system.
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4.	 In the Properties palette, choose the Edit Type button; the Type Properties dialog box is 
displayed.

5.	 Choose the Duplicate button from the upper right corner of this dialog box; the Name 
dialog box is displayed. Enter Generic- 9” for Imperial (Generic- 230mm for Metric system) 
in the Name edit box and then choose the OK button; the dialog box is closed and the 
Generic - 9” for Imperial system (Generic - 230mm for Metric system) is selected in the 
Type drop-down list.

6.	 Now, choose the Edit button from the value field corresponding to the Structure parameter; 
the Edit Assembly dialog box is displayed.

7.	 In the Edit Assembly dialog box, click on the value field 

Figure 3-58  Setting the Top 
Constraint parameter using the 
Properties palette

of the Thickness column corresponding to the Structure[1] 
function parameter. Enter 9” for Imperial or enter 230mm 
for Metric and then choose the OK button; the Edit 
Assembly dialog box is closed. 

8.	 Now, choose OK button; the Type Properties dialog box is 
closed and the Generic - 9” wall type is selected in Imperial 
system or Generic - 230mm is selected in the Type Selector 
drop-down list.

Modifying the Properties of the Exterior Wall
	 After sketching the wall type, you need to modify the 

instance properties of the wall type using the Properties 
palette. 

1.	 In the Properties palette, ensure that the Location Line 
parameter has Wall Centerline as the default value. Click 
in the value field of the Top Constraint instance parameter; 
a drop-down list is displayed. Select Up to Level: Level 2 
from the drop-down list displayed, as shown in Figure 3-58 
and choose the Apply button.

Sketching the Exterior Wall Segment
	 In this section, you will sketch the exterior wall segment.

1.	 Invoke the Rectangle tool from the Draw panel of the Modify | Place Wall tab.

2.	 Click between the four elevation symbols in the drawing area to specify the first point. Next, 
move the cursor toward bottom right to draw a rectangle. On doing so, a rectangle starts 
creating from a specified point. Now, click to specify the endpoint, as shown in Figure 3-59.
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Figure 3-59  The temporary dimensions being displayed on the 
sketched wall

                                

3.	 Click on the temporary dimension of the horizontal wall displayed; an edit box appears 
showing the current dimension of the wall segment.

4.	 Enter 80’ for Imperial or 24000 mm for Metric in the edit box and then press ENTER; the 
length of the horizontal wall is modified to the entered value. 

5.	 Similarly, click on the temporary dimension of vertical wall; an edit box appears. Enter 40’ 
for Imperial or 12000 mm for Metric in the edit box and then press ENTER; the length of 
the vertical wall is modified to the entered value. Press ESC twice to exit the Modify | Walls 
tab.

	 The external wall profile is drawn with the specified dimensions, as shown in Figure 3-60.

Figure 3-60  The completed exterior wall segment of Office Building
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Sketching Other Exterior Wall Segments
	 In this section, you need to create other exterior wall segments.

1.	 Choose the Wall: Architectural tool from the Architecture > Build > Wall drop-down; 
the Modify | Place Wall tab is displayed.

2.	 Choose the Line tool from the Draw panel of the Modify | Place Wall tab. Ensure that 
the Chain check box is selected in the Options Bar. Now, place the cursor to the lower left 
corner of the wall and move toward right. When temporary dimension appears, enter 20’ 
for Imperial or enter 6000 mm for Metric and then press ENTER.

3.	 Draw 13’0” line in Imperial system or 3900 mm line in Metric system from that point in 
downward direction, as shown in Figure 3-61.

Figure 3-61  The other exterior wall segment created outside 
the Office Building

4.	 After drawing the line, the wall starts creating dynamically with one end attached to the 
specified point and the other end attached to the cursor. Move the cursor horizontally toward 
the right so that you see a dashed horizontal line inside the wall segment. Now, enter 20’0” 
for Imperial or 6000 mm for Metric as the value of the length; an edit box is displayed with 
the dimension you have entered, as shown in Figure 3-62.
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Figure 3-62  Creating the second exterior wall segment

5.	 Now you need to draw the third wall segment. To do so, move the cursor upward and enter 
13’ for Imperial or enter 3900 mm for Metric as the value of the length and press ENTER. 
The other exterior wall segments are created, as shown in Figure 3-63. 

Figure 3-63  The completed exterior profile of Office Building
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6.	 Now, press ESC or choose the Modify button to clear the selection.	  

Selecting the Interior Wall Type
	 In this section, you will select the interior wall type.

1.	 Invoke the Wall: Architectural tool; the wall instance parameters are displayed in the 
Properties palette. In this palette, select the required wall type  from the Type Selector 
drop-down list, as shown in Figure 3-64. 

		  For Imperial	 BasicWall Generic - 5”
		  For Metric	 BasicWall Generic - 90mm

Figure 3-64  Selecting the interior wall type 
from the Type Selector drop-down list

2.	 In the Options Bar, select the Wall Centerline option from the Location Line drop-down 
list, if it is not selected by default. 

Sketching Other Interior Walls
	 Next, you will sketch other horizontal or vertical interior walls by specifying their start point 

and end point using different object snap options.

1.	 Move the cursor near the top left end of the wall and then start moving the cursor horizontally 
toward the right. Enter 10’0” for Imperial or 3000 mm for Metric when the temporary 
dimensions and the intersection object snap appear, as shown in Figure 3-65. Now, press 
ENTER; the starting point of the first interior wall is specified. 
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Figure 3-65  Specifying the distance for starting the first interior wall segment

2.	 Next, move the cursor vertically downward and enter 30’ for Imperial (9000 mm for Metric) 
and close the wall segment, as shown in Figure 3-66; the interior wall segment is sketched.

Figure 3-66  Specifying the first interior wall segment
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3.	 To sketch the second interior wall, move the cursor to the upper endpoint of the interior 
wall you just created and then move the cursor vertically downward. Enter 11’0” for Imperial 
or 3300 mm for Metric when the temporary dimension and the intersection object snap 
appears as shown in Figure 3-67.

Figure 3-67  Specifying the starting point of second interior 
wall segment

4.	 Press SHIFT and move the cursor toward right near the right exterior wall segment. Now, 
click to specify the location of the endpoint of the wall segment; the second interior wall 
segment is sketched, as shown in Figure 3-68.

Figure 3-68  Sketching the second interior wall

5.	 To sketch the third interior wall, place the cursor toward the lower right corner of the wall 
segment and move the cursor upward. Enter 11’0” for  Imperial or 3300 mm for Metric 
and then press ENTER, as shown in Figure 3-69; the starting point of the interior wall is 
specified.

6.	 Next, move the cursor in a horizontal direction toward the left. Enter 50’0” for Imperial and 
15000 for Metric and then press ENTER, as shown in Figure 3-70. Ensure that the Chain 
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option is selected. Now, move the cursor vertically downward near the lower exterior wall 
segment; the interior wall segment is sketched, as shown in Figure 3-71. 

Figure 3-69  Specifying the distance for starting the first interior wall segment

Figure 3-70  Specifying the distance for starting the interior wall segment

Figure 3-71  Sketched wall segment
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7.	 Similarly, you can draw other interior walls by using the Line tool, refer to Figure 3-72. 

8.	 Choose the Modify button to exit the tool.

Figure 3-72  Layout of internal walls for Office Building

Modifying Levels
	 In this section, you will modify levels in the elevation view.

1.	 In the Project Browser, double-click on the North - Archi under the Elevations (Building 
Elevation) head; the north elevation is displayed within the existing levels in the drawing 
window.

	
2.	 Choose the Zoom in Region tool from the Navigation Bar to enlarge the right portion 

of the elevation showing the levels, refer to Figure 3-73.

3.	 To rename the levels, move the cursor over Level 1 in the Project Browser and right-click; 
a shortcut menu is displayed.

4.	 Choose the Rename option from the shortcut menu; the edit box is displayed.

5. 	 In the displayed edit box, enter Ground Floor and choose the OK button; you are prompted 
to verify whether you want to rename the corresponding levels and views.

6.	 Choose the Yes button to rename the level and views. The level is immediately renamed in 
the elevation view.

7.	 Similarly, rename the Level 2 as Roof , as shown in Figure 3-73.
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Figure 3-73  Renamed levels and views for the Office Building

Creating Grid Lines
	 You can use the plan view to add grids to the project using the Grid tool. Grids are 

automatically numbered as they are created. Now, you will create Grids in the sequence as 
shown in the sketch plan.

1.	 Double-click on Ground Floor from the Floor Plans head in the Project Browser to display 
the ground floor plan in the drawing window.

2.	 Next, choose the Grid tool from the Datum panel of the Architecture tab; the Modify | 
Place Grid tab is displayed.

3.	 Now, ensure that the Line tool is chosen in the Draw panel.

4.	 Move the cursor near the top left corner of the exterior wall profile  till a vertical extension 
line is displayed. Click to specify the start point of the grid line when the temporary dimension 
of 3’0” for Imperial or 900 mm for metric is displayed from the centerline of the exterior 
wall, as shown in Figure 3-74.

5.	 Move the cursor vertically downward and click outside the south wall to specify the endpoint 
of the grid line, as shown in Figure 3-75.

Note
If grid lines are not visible in the drawing, choose the Visibility/Graphics tool from the 
Graphics panel of the View tab to display the Visibility/Graphic Overrides for Floor Plan 
dialog box. In the Annotation Categories tab of this dialog box, select the Grids check box; the 
grid lines will become visible.

	 The same procedure can be followed to draw grid lines for the interior walls. As the 
thickness of the interior wall is 5” or 90 mm, you can specify 2 1/2” or 64 mm as the offset 
distance to draw grid lines for the interior walls.
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Figure 3-74  Specifying the start point of the grid line

Figure 3-75  Specifying the grid line drawn 
at first point

6.	 Repeat steps 3, 4, and 5 to create other vertical and horizontal grid lines in the sequence 
of their numbers using the Pick Line tool. After adding grid lines, press ESC twice to exit. 
Figure 3-76 shows the floor plan after adding grid lines.
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Figure 3-76  The horizontal and vertical grid lines created for wall 
centerline

Note
You can rename a grid by selecting it from the drawing and then entering a value corresponding 
to the value column for the Name parameter in the Properties palette. The entered value will be 
the new name of the grid.   	

	 This completes the tutorial for creating walls, adding grids, and modifying levels of the 
building envelope project.

Saving the Project
In this section, you need to save the project and the settings using the Save As tool.

1.	 Choose Save As > Project from the File menu; the Save As dialog box is displayed. 

2.	 In this dialog box, browse to C:\rmp_2022\c03_rmp_2022_tut and then enter c03_
Office_BuildingI_tut1 for Imperial or M_c03_Office_BuildingI_tut1 for Metric in the 
File Name edit box.

3.	 Now, choose the Save button; the Save As dialog box closes and the project file is saved.

Closing the Project
1.	 Choose the Close option from File menu.

Tutorial 2					            Office Building II
In this tutorial, you will add doors and windows and also add a floor and a ceiling to the 
c03_Office_BuildingI_tut1.rvt project file for Imperial or M_c03_Office_BuildingI_tut1.rvt project 
file for Metric created in Tutorial 1 of Chapter 3. Refer to Figure 3-77 for adding these elements. 
The dimensions and the text have been given for reference and are not to be added. The project 
file name and parameters to be used are given next.		        (Expected time: 30 min)
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1.	 Project File created in Tutorial 1 of Chapter 3.
			   For Imperial	 c03_Office_BuildingI_tut1.rvt
		  For Metric	 M_c03_Office_BuildingI_tut1.rvt

2.	 Door types to be used
			   For Imperial	 1 and 17- Double - Panel 1: 72” x 78”
					     2 and 3- Single - Flush: 30” x 84” 
					     4,5 and 6 Single - Flush Vision: 36” x 84”
					     7- Single- Glass 1: 36” x 84”
					     8 to 16- Single - Decorative 2: 36” x 84”

			   For Metric	 1 and 17- M_Door-Exterior-Double 1800 x 2100mm 
					     2 and 3- M_Door-Passage-Single-Flush 750 x 2100mm 
					     4,5 and 6 M_Door-Passage-SingleVision_Lite 900 x 2100mm
					     7- M_Door-Passage-Single-Full_Lite 900 x 2100mm
					     8 to 16- M_Door-Passage-Single-Two_Lite 900 x 2100mm

3.	 Window types to be used
			   For Imperial	 Fixed- 24” x 48” 	
					     Fixed- 60” x 48” (with modified width)

			   For Metric	 M_Fixed- 0610 x 1220 mm 	
					     M_Fixed- 1524 x 1220 mm (with modified width)

4.	 Floor type: 
			   For Imperial	 Generic 12”, Extents- to wall core.
			   For Metric	 Generic 300 mm, Extents- to wall core.

5.	 Ceiling type: 
			   For Imperial	 Generic, Level- 8’6” from the floor level.
			   For Metric	 Generic, Level- 2590 mm from the floor level.

6.	 File name to be assigned:
			   For Imperial	 c03_Office_BuildingII_tut2.rvt
			   For Metric 	 M_c03_Office_BuildingII_tut2.rvt

	 The following steps are required to complete this tutorial:

a.	 Open the required file and hide the annotation tag such as grids.
			   For Imperial	 c03_Building-EnvelopeI_tut1.rvt file
			   For Metric	 M_c03_Building-EnvelopeI_tut1.rvt file
b.	 Add doors by invoking the Door tool and selecting the type of door from the Type Selector 

drop-down list, refer to Figures 3-78 through 3-81.  
c.	 Invoke the Window tool. Select the window type by using the Type Selector drop-down list. 
d.	 Place the windows, as shown in Figure 3-77.
e.	 Place the windows at the exact location as per the given dimensions, refer to Figures 3-82 

through 3-86.
f.	 Create the floor using the Floor tool, refer to Figures 3-88 through 3-90.  
g.	 Create the ceiling using the Ceiling tool.
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Figure 3-77  Sketch for adding doors and windows to the Office Building project

Opening the Existing Project and Hiding Annotation Tags
	 In this section, you will open the specified project and then hide the annotation symbols 

and tags such as grids using the Visibility/Graphics tool.

1. 	 Choose Open > Project from the File menu and open the c03_Office_BuildingI_tut1.rvt 
project file for Imperial or M_c03_Office_BuildingI_tut1.rvt for Metric created in Tutorial 1 
of Chapter 3. You can also download this file from https://www.cadcim.com. The path of the 
file is as follows: Textbooks > Civil/GIS > Revit MEP > Exploring Autodesk Revit 2022 for MEP.

2.	 Now, to hide the annotation symbols and tags such as grids, choose the Visibility/Graphics 
tool from the Graphics panel of the View tab; the Visibility/Graphics Overrides for Floor 
Plan: Ground Floor dialog box is displayed.

3.	 Choose the Annotation Categories tab from this dialog box, and clear the check box 
corresponding to the Grids under the Visibility column.

4.	 Now, choose the Apply button and then the OK button;  the Visibility/Graphics Overrides 
for Floor Plan: Ground Floor dialog box is closed and the specified settings are applied to 
the plan view of the Ground Floor.

Adding Doors
	 In this section, you need to add doors at an approximate location and then modify their 

location by specifying the exact dimension. You will use the Load Family tool to load the 
desired door type in the project.
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1.	 Invoke the Door tool from the Build panel of the Architecture tab. Alternatively, type DR; 
the Revit window is displayed prompting you to load the door family, as no door family is 
loaded in the Revit. 

2.	 Choose the Yes button; the Load Family dialog box is displayed.

3.	 In the Load Family dialog box, load doors for Imperial from English-Imperial>Doors 
and for Metric, load doors from English>Doors :

		  For Imperial	 1- Double-Panel 1: 72” x 78” 
				    2- Single-Flush: 30” x 84”
				    3- Single-Flush Vision: 36” x 84”
				    4- Single-Glass 1: 36” x 84”
				    5- Single-Decorative 2: 36” x 84”
				  
		  For Metric	 1- M_Door-Exterior-Double 1800 x 2100mm 
				    2- M_Door-Passage-Single-Flush 750 x 2100mm			 

			   3- M_Door-Passage-SingleVision_Lite 900 x 2100mm
				    4- M_Door-Passage-Single-Full_Lite 900 x 2100mm
				    5- M_Door-Passage-Single-Two_Lite 900 x 2100mm			 

				  
4.	 On invoking the Door tool, the properties of the door to be added are displayed in the 

Properties palette. In the palette, select the desired type of door from the Type Selector 
drop-down list.

			   For Imperial	 Single-Flush: 30” x 84”
			   For Metric	 M_Door-Passage-Single-Flush 750 x 2100mm

5.	 Before placing the door, ensure that the Tag on Placement tool is not selected in the Tag 
panel of the Modify | Place Door tab. 

6.	 Move the cursor close to the interior wall of the pantry area to display the door symbol, as 
shown in Figure 3-78. Notice that as you move the cursor, the side of the door is changed. 
Click on the interior wall; the door is created at the specified location along with a tag on 
it.

Figure 3-78  Specifying the location of the pantry door

7.	 To move the door to the exact location, choose the Modify button in the Select panel of the 
Modify | Place Door tab and select the door added to the drawing; the selected door gets 
highlighted in blue and the controls and the related temporary dimensions are displayed in it. 
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8.	 Since the location of the door is given with reference to the side interior wall, click on the 
lower temporary dimension, and then enter 2’0” for Imperial or 600 mm for Metric, as 
shown in Figure 3-79. Next, press ENTER; the door moves to the specified location.

Figure 3-79  Moving the door to the exact location

9.	 Choose the Modify button from the Select panel and then select the door inserted in the 
drawing; the door gets highlighted and its controls are displayed. Next, flip the door swing, 
as shown in Figure 3-80.

Figure 3-80  Flipping the door

10.	 To place the door type at the entrance, invoke the Door tool from the Build panel; the 
Modify | Place Door tab is displayed.

11.	 In the Type Selector drop-down list, select the desired door type, as specified in the project 
parameters.

			   For Imperial	 Double - Panel 1:  72” x 78”
			   For Metric	 M_Door-Exterior-Double 1800 x 2100mm

12.	 Move the cursor near the exterior wall side near to the washroom, as shown in Figure 3-81, 
and click to add the entrance door close to this location. 

13.	 Choose the Modify button and select the door and then click on the right side dimension 
to set it to 5’0” for Imperial or 1500 mm for Metric, as specified in Figure 3-81.
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Figure 3-81  Using the dimension to place the door at the exact location

14.	 Add the other types of door in other areas at a specified distance from the internal wall, 
refer to Figure 3-77. 

Tip
Doors and door openings can also be added to 3D view, sections, and elevations. However, you 
need to choose an appropriate view to place the door. You can use the temporary dimensions 
to place the door at the exact location. If the door is not placed correctly, Autodesk Revit alerts 
you about the conflict and prompts you to take an appropriate action.

Adding Windows
	 In this section, you will add windows to the building envelope project.

1.	 Invoke the Window tool from the Build panel of the Architecture tab; Revit window is 
displayed prompting you to load a family as no window family is loaded. Choose the Yes 
button; the Load Family dialog box is displayed.

2.	 In the Load Family dialog box, select the Fixed family type from the Windows folder of 
the English-Imperial folder or M_Fixed for Metric from the English folder. Next, choose 
the Open button; the dialog box is closed.

	
3.	 Click on the Type Selector drop-down list to view the in-built window types. To create the 

window number 1, select the desired window type from the drop-down list. 
	 		  For Imperial	 Fixed 24” x 48”
			   For Metric	 Fixed 0610 x 1220 mm
	
4.	 Move the cursor close to the exterior wall of the reception to display window symbol, as 

shown in Figure 3-82. Add the window by clicking on the inner face of the exterior wall; the 
window is created at the specified location.

5.	 To move the window to the exact location, choose the Modify button from the Select panel 
and then select the window from the drawing; it gets highlighted in blue and its controls 
are displayed. 
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Figure 3-82  Adding the window at the Reception area

6.	 Click on the upper temporary dimension and enter 3’0” for Imperial or 900 mm for Metric, 
as shown in Figure 3-83. Press ENTER; the window is moved to the specified location. 
Similarly, add other windows of the same type near the internal wall of the I.T. Server 
room (mentioned in Tutorial 1) by invoking the Window tool from the Build panel, refer 
to Figure 3-77.

Figure 3-83  Specifying the exact location of the window

      

7.	 After adding the window in internal wall of the IT Server room, you need to move it to 
the exact location. To do so, select the window; it is highlighted in blue. Click on the left 
temporary dimension; an edit box is displayed. Enter 2’0” for Imperial or 600 mm for Metric 
in the edit box, as shown in Figure 3-84, and then press ENTER; the window is moved to 
the desired location. Press ESC and exit.	

 

Figure 3-84  Specifying the location of the IT Server window 
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	 Now, you need to add the windows of type 2 in the drawing. These windows have a 
modified width of 5’0” in Imperial or 1500 mm for Metric. To add these windows, select the 
Fixed: 24” x 48” window type in Imperial system, Fixed: 0610 x 1220 mm window type in 
Metric system and then create its duplicate. Modify its width to 5’0” for Imperial or 1500 
mm for Metric by using the Type Properties dialog box and add the window at the desired 
location.

8.	 Invoke the Window tool from the Build panel of the Architecture tab; the Modify | Place 
Window tab is displayed.

9.	 In the Type Selector drop-down list, select the Fixed: 24” x 48” window type for Imperial 
or Fixed: 0610 x 1220 mm window type for Metric. Next, choose the Edit Type button in 
the Properties palette; the Type Properties dialog box is displayed. 

10.	 In this dialog box, choose the Duplicate button; the Name dialog box is displayed. In the 
Name edit box, enter 60” x 48” for Imperial or enter 1524 x 1220 mm for Metric and then 
choose the OK button.

11.	 In the Value field for the Width type parameter, enter 5’0” for Imperial or 1524mm for 
Metric and then choose the Apply and OK buttons to close the Type Properties dialog box 
and return to the drawing window. 

	 Notice that the Fixed: 60” x 48” window type in Imperial or Fixed: 1524 x 1220 mm 
window type in Metric is added to the Type Selector drop-down list. 

12.	 Move the cursor near the exterior wall of the pantry and click to place the window, as shown 
in Figure 3-85. Press ESC twice to exit.

Figure 3-85  Specifying the location of the bedroom window

13.	 Now, select the added pantry window; the window gets highlighted in blue color and its 
controls are displayed. Click on the temporary dimension displayed at the bottom and enter 
6’0” for Imperial or 1800 mm for Metric to specify the location of the pantry window, refer 
to Figure 3-85; the window is moved to the desired location. Similarly, add the windows of 
the same type to the walls of the other rooms and specify their respective locations based 
on the given sketch plan, refer to Figures 3-86.
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	 This completes the tutorial of adding doors and windows to the Building Envelope II project. 
The Level 1 plan should look similar to the plan shown in Figure 3-86.

Figure 3-86  Complete project plan with doors and windows

                        

Note
You can place doors and windows at nearby position, refer to Figure 3-86.

14.	 To view the plan in 3D, choose the Default 3D View tool from View > Create > 3D View 
drop-down; the 3D view of the project is displayed, as shown in Figure 3-87.

Figure 3-87  3D view of the project
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Creating the Floor
	 In this section, you will add floor to the building using the Floor tool.  

1.	 Double-click on the Ground Floor under the Floor Plans head; the corresponding view is 
displayed.

2.	 To add a floor to the building, choose the Floor: Architectural  tool from Architecture >  
Build > Floor drop-down; the Modify | Create Floor Boundary tab is displayed along 
with the Options Bar. Notice that the drawing area fades when you invoke the Floor tool, 
which indicates that you are in the sketch mode.

3.	 In the Options Bar, select the Extend into wall (to core) check box, if it is not
selected. Also, notice that the Pick Walls tool is chosen by default in the Draw panel.

4.	 Move the cursor near the center of the north wall of the building plan; the wall is highlighted. 
Now, click to draw the line.

5. 	 Similarly,  move the cursor near the west wall of the building plan and click when the wall 
is highlighted. On doing so, a sketched boundary appears in magenta color.

6.	 Repeat the procedure followed in steps 3 and 4 and sketch the boundary of the floor on 
other walls, as shown in Figure 3-88.

Figure 3-88  The floor boundary sketched using the Pick Walls tool

7.	 After sketching, you will notice that the floor boundary intersects at the interior wall of 
washroom. To separate the floor boundary, choose the Split Element tool from the Modify 
panel of the Modify | Create Floor Boundary tab.
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8.	 Now, split the boundary at the corners where line

Figure 3-89  Selecting the Generic 12” 
floor type

intersects and then select the split element and 
press DELETE.

   
9.	 Next, choose the Finish Edit Mode button from 

the Mode panel to complete the sketching of the 
floor. 

10. 	By default, Floor : Generic 12” option for Imperial 
(Floor : Generic 300mm for Metric) from the Type 
Selector drop-down list in the Properties palette 
is selected, as shown in Figure 3-89. 

       
11.	 Choose the Modify button from the Select panel 

of the Modify | Floor tab to exit the Floor: 
Architectural tool. The floor is created for the 
project, as shown in Figure 3-90. 

Creating the Ceiling Head under 
Architectural Head
1.	 In the Project Browser, select 1-Ceiling Mech 

under the Mechanical head and right-click to 
display a flyout. From this flyout, choose Duplicate 
Views > Duplicate; the 1 - Ceiling Mech Copy 1 
option is displayed under the Mechanical head.

Figure 3-90  The Generic 12” type of the floor created

2.	 Double click on 1 - Ceiling Mech Copy 1  to display the corresponding view. Now, in the 
Properties palette, click on the value field corresponding to the Discipline parameter. Select 
the Architectural discipline from the drop-down list and choose the Apply button to apply 
the changes.
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3.	 In the Project Browser, 1 - Ceiling Mech Copy 1 is displayed under the Architectural 
head.

4.	 Select 1 - Ceiling Mech Copy 1 under the Architectural Plan head and right-click to display 
a flyout. From the flyout, choose the Rename option; the edit box is displayed. Enter Level 1 
in the edit box and choose the OK button; the dialog box is closed and the view is renamed 
to Level 1.

5.	 Repeat the procedure followed in steps 1 through 5 to add another level as Level 2 from 
Mechanical head into Architectural head.

Creating the Ceiling
	 After creating the floor for the project, you need to add a ceiling to it. You will use the 

Ceiling tool to create the ceiling.

	 Before creating the ceiling, transform the current view to the ceiling plan view of the first 
floor. 

1.	 Double-click on Level 1 from the Ceiling Plans head in the Project Browser.

2.	 Invoke the Ceiling tool from the Build panel of the Architecture tab; the Modify | Place 
Ceiling tab is displayed. 

3.	 To assign a type to the ceiling, click on the Type Selector drop-down list in the Properties 
palette and then select the Generic option from it. 

	 Next, you need to define the exact height of the ceiling.
       

4.	 In the Properties palette, click on the value field of the Height Offset From Level instance 
parameter and enter 8’6” for Imperial or 2590 mm for Metric. Next, choose the Apply 
button; the new height is assigned to the ceiling.   

5.	 Next, move the cursor on any of the enclosed space and click  to create a ceiling. Note that 
the created ceiling is not distinctly visible in the ceiling plan because the ceiling type selected 
has a plain board finish.

6.	 Repeat step 5 to create individual ceilings for every enclosed space in the Office Building II 
project. After creating all the ceilings, press ESC twice.

7.	 Choose the Default 3D View tool from the 3D View drop-down of the Create panel in the 
View tab; the 3D view of the project with the ceiling created is displayed. You can move the 
cursor over the ceiling of the room to highlight and display it, as shown in Figure 3-91.

Note
If the 3D view is in halftone grey, you need to change the discipline of the 3D view to Architecture or 
Coordination from the instance properties displayed in the Properties palette.
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Figure 3-91  Displaying the ceiling of the Office Building II project

Saving the Project
In this section, you need to save the project and the settings using the Save As tool.

1.	 To save the project with the settings, choose Save As > Project from the File menu; the 
Save As dialog box is displayed. 

2.	 In this dialog box, browse to C:\rmp_2022\c03_rmp_2022_tut and then enter c03_
Office_BuildingII_tut2 for Imperial or M_c03_Office_BuildingII_tut2 for Metric in the 
File Name edit box.

3.	 Now, choose the Save button; the Save As dialog box closes and the project file is saved.

Closing the Project
1.	 To close the project, choose the Close option from the File menu.

Self-Evaluation Test	
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Using the __________ button in the Properties palette, a copy of an existing door type can 
be created.

2.	 You can select a wall type from the __________ drop-down list.

3.	 The __________ tool can be used to attach walls to the floor.

4.	 Using the __________ tool, you can create grids by picking elements.

5.	 The __________ type parameter indicates the height of a door.

6.	 You can control the visibility of a level head. (T/F)
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7.	 You cannot copy or array grids. (T/F)

8.	 After creating a wall type, you can modify its properties. (T/F)

9.	 You can add doors and windows in plan view only. (T/F)

10.	 You can use the By Face tool to cut openings on the faces of floors and ceilings. (T/F)

Review Questions
Answer the following questions:

1.	 Which of the following keys needs to be held to add elements to a selection?
	 	
		  (a) TAB				   (b) CTRL
		  (c) SHIFT			   (d) ESC

2.	 Which of the following parameters of a door is an instance property?

		  (a) Level			   (b) Thickness
		  (c) Door Material		  (d) Fire Rating

3.	 Which of the following sketching tools can be used to create a curved wall?

		  (a) Rectangle			   (b) Fillet Arc
		  (c) Line				   (d) Polygon	

4.	 You can create a radial grid pattern using the Grid tool. (T/F)

5.	 Levels, once created, cannot be modified. (T/F)

6.	 You can create an opening in the ceiling using the Cut tool. (T/F)	

7.	 The Chain option can be enabled or disabled without exiting the Wall: Architectural tool. 
(T/F)

8.	 The location line parameter is an instance property of a wall. (T/F) 

9.	 Walls can be attached to the floors using the Join Geometry tool. (T/F)

10.	 Door tags increase automatically as you add doors to a project. (T/F)



Creating Building Envelopes			   3-91

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

EXERCISE
Exercise 1					           Residential Building

Create the exterior and interior walls of a residential building and then add doors and windows 
to them. Create floor and ceiling and then add grids to the walls of the Residential building, 
refer to Figure 3-92. Do not add dimensions or texts as they are given only for reference. Figure 
3-93 shows the three dimensional view of the residential building with the added floors and 
ceilings. The project parameters for this exercise are given next.	       (Expected time: 1 Hour)

1.	 Project File - 
		  For Imperial	 Systems-Default.
		  For Metric	 Systems-Default_Metric.

2.	 Discipline - Architectural.

3.	 Rename Level 1 - First Floor, Level 2 - Second Floor.	

4.	 Exterior wall type - 
		  For Imperial	 Basic Wall - Exterior Brick on Mtl. Stud.
		  For Metric	 Basic Wall - Exterior Brick on Mtl. Stud.
	 .
5.	 Interior wall type -
		  For Imperial	  Basic Wall: Generic- 5”.
		  For Metric	  Basic Wall: Generic- 90 mm.

6.	 Height of wall - Top Constraint - Upto Level 2.

7.	 Door type to be used:
		  For Imperial	 Main door - Double - Glass 2 - 36” x 84” 
				    Bedroom doors - Single - Flush 30” x 84”
				    Washroom door - Single Flush Vision - 36” x 84” 
		  For Metric	 Main door - Double - Glass 2 - 1830 x 1981mm 	 
				    Bedroom doors - Single - Flush 0762 x 2134mm
				    Washroom door - Single Flush Vision - 0915 x 2134 mm 

8.	 Window type to be used:
		  For Imperial	 Fixed with Trim - 36” x 24”
		  For Metric	 Fixed with Trim - 0915 x 0610 mm

9.	 Floor type - 
		  For Imperial	 Floor: Generic- 12”.
		  For Metric	 Floor: Generic- 300mm

10.	 Ceiling type - Generic.
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11.	 File name to be assigned:
		  For Imperial	 c03_Residential-Building_exer1.rvt
		  For Metric	 M_c03_Residential-Building_exer1.rvt

Figure 3-92  Sketch plan of walls with doors and windows, and floor and 
ceiling added to the building

Figure 3-93  Three dimensional view of residential building with added floors 
and ceilings

Answers to Self-Evaluation Test
1. Duplicate,  2. Type-Selector, 3. Attach Top/Base, 4. Pick Line, 5. Height, 6. T, 7. F, 8. T, 
9. F, 10. T


